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Ievads

Pateicamies, ka izvēlējāties Medtronic Diabetes par savu partneri, kas palīdzēs jums un jūsu

pacientiem labāk vadīt diabēta ārstēšanu. Mēs ticam, ka jūsu darbam būs noderīga

programmatūras CareLink® Pro jaunāko sasniegumu tehnoloģija un vienkārša  ar izvēlni

darbināma lietotāja saskarne.

Ar programmatūru CareLink Pro var iegūt un saglabāt datus, kā arī ģenerēt atskaites par pacientu

ārstēšanu un diagnostiku. To var arī izmantot, lai piekļūtu datiem, kas attiecas uz sūkni un

mērītāju, kā arī no sensora iegūtiem glikozes līmeņa datiem, kurus jūsu pacienti ir

augšupielādējuši terapijas tīmekļa vadības sistēmā CareLink® Personal, kas darbojas ar

programmatūru CareLink Pro.

Funkcijas

CareLink Pro ir diabēta ārstēšanas vadības programmatūra personāliem datoriem (personal

computer — PC). Tā ietver šādas funkcijas:

• iespējams izveidot pacienta ierakstus, saglabājot no pacienta ierīces iegūtos datus, kā arī

terapijas datus no pacienta CareLink Personal konta;

• var nosūtīt uz sistēmu insulīna sūkņu, monitoru un glikozes līmeņa asinīs mērītāju datus,

uzglabāt tos un pēc tam izmantot ziņojumu ģenerēšanai;

• programmatūrai ir arī iespēja saskaņoti darboties ar sistēmu CareLink Personal, ļaujot piekļūt

datiem, kurus pacienti ir saglabājuši ierīcē. Tas noder, lai izveidotu aktuālus ziņojumus starp

iestādes apmeklējumiem, tādēļ vairs nav nepieciešams nolasīt ierīces datus apmeklējuma

laikā;

• izmantojot pacienta ierakstos saglabātos ierīces datus, var izveidot dažādus ārstēšanas gaitas

ziņojumus. Ziņojumi atvieglo ārstēšanas problemātisko jautājumu risināšanu, piemēram, ārsta

norādījumu ievērošanu, ārstēšanas modeļus un izņēmumus;

• sistēma brīdina, kad lejupielādēšanai un instalēšanai ir pieejami programmatūras

atjauninājumi. Tādējādi tiek nodrošināta pieeja jaunākajām sistēmas funkcijām;
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• lietotājiem, kuriem programmatūra CareLink Pro vēl nav zināma, ir pieejama funkcija Guide

Me (Vadi mani). Tajā ir sniegtas norādes un padomi par izpildāmajiem uzdevumiem;

• visā programmatūrā ir integrēta palīdzības sistēma, kurā sniegta informāciju par konkrētām

interesējošām jomām.

Drošība

• Pieeju programmatūrai CareLink Pro var aizsargāt ar paroli.

• Pacienta datu pārsūtīšana no CareLink Personal konta ir šifrēta, izmantojot tipveida

drošligzdu slāņa (Secure Sockets Layer — SSL) tehnoloģiju.

Saistītie dokumenti

Visi Medtronic MiniMed dokumenti attiecas uz informāciju, kas ir saistīta ar ierīci un nav sīki

izklāstīta šajā lietotāja rokasgrāmatā.

PIEZĪME: lai iegūtu informāciju par mērītājiem saistībā ar ierīci, skatiet tiem pievienotās

ražotāja instrukcijas.

• Paradigm insulīna sūkņa lietotāja rokasgrāmata

• Guardian REAL-Time monitora lietotāja rokasgrāmata

• Sensora funkciju lietotāja rokasgrāmata

• ComLink lietotāja rokasgrāmata

• CareLink USB lietotāja rokasgrāmata

Palīdzība

Ja Jums ir nepieciešama papildu palīdzība saistībā ar šīs sistēmas lietošanu, lūdzu, sazinieties ar

vietējo pārstāvi. Starptautiskā kontaktinformācija ir atrodama šajā tīmekļa vietnē:

http://www.minimed.com/contact/international-locations

Atbalstītās ierīces

Programmatūra CareLink Pro saņem datus no turpmāk minētajām ierīcēm.

PIEZĪME: dažas šī programmatūras atbalstītās ierīces var nebūt pieejamas visās valstīs,
kurās ir apstiprināta šīs programmatūras lietošana.
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Insulīna sūkņi/glikozes monitori

Medtronic MiniMed sūkņi: 508

Medtronic MiniMed Paradigm® sērijas sūkņi: 511, 512, 712, 515, 715, 522, 722, 522K, 722K,
Paradigm® Veo™ (554, 754)

Guardian REAL-Time monitori:
CSS-7100

CSS-7100K

Ražotājs Glikozes līmeņa asinīs mērītāji

Saistītie mērītāji:
• Bayer CONTOUR® LINK

• Monitors BD Paradigm Link® glikozes līmeņa asinīs
noteikšanai

Bayer:

• CONTOUR® USB

• Ascensia BREEZE®

• BREEZE® 2

• CONTOUR®

LifeScan:

• OneTouch® UltraSmart®

• OneTouch® Profile®

• OneTouch® Ultra®

• OneTouch® Basic®

• OneTouch® FastTake®

• OneTouch® SureStep®

• OneTouch® Ultra® 2

• OneTouch® UltraMini®

• OneTouch® UltraEasy®

BD: • Logic®

Bayer Ascensia™ DEX™ grupa, tostarp šādi saderīgi
mērītāji:

• Ascensia™ DEX™

• Ascensia™ DEX™ 2

• Ascensia™ DEXTER-Z® II

• Glucometer™ DEXTER-Z®

• Ascensia™ ESPRIT® 2

• Glucometer™ ESPRIT®

• Glucometer™ ESPRIT® 2

Bayer Ascensia™ ELITE™ grupa, tostarp šādi saderīgi
mērītāji:

• Ascensia™ ELITE™

• Glucometer™ ELITE™ XL
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Ražotājs Glikozes līmeņa asinīs mērītāji

Abbott:

• FreeStyle®

• FreeStyle® Lite®

• FreeStyle® Freedom®

• FreeStyle® Freedom Lite®

• Precision Xtra®

• TheraSense FreeStyle®

• FreeStyle® Flash®

• FreeStyle® Papillon™ mini

• FreeStyle® Mini®

• Optium Xceed™

• Precision Xceed™

Roche:

• Accu-Chek® Aviva

• Accu-Chek® CompactPlus

• Accu-Chek® Compact

• Accu-Chek® Active

Sakaru ierīces

CareLink® USB Lietošanai ar MiniMed Paradigm sērijas insulīna sūkni
un monitoru Guardian REAL-Time.

Monitors Paradigm Link® glikozes līmeņa asinīs
noteikšanai

Lietošanai ar sūkni MiniMed Paradigm vai monitoru
Guardian REAL-Time. (Detalizētu informāciju par
nepieciešamo aparatūru skatiet monitora Paradigm
Link® glikozes līmeņa asinīs noteikšanai lietotāja
rokasgrāmatā.)

ComLink

Lietošanai ar sūkni MiniMed Paradigm un monitoru
Guardian REAL-Time. (Detalizētu informāciju par
nepieciešamo aparatūru skatiet ComLink lietotāja
rokasgrāmatā.)

Com-Station
Lietošanai ar sūkni Medtronic MiniMed 508. (Detalizētu
informāciju par nepieciešamo aparatūru skatiet 
Com-Station lietotāja rokasgrāmatā.)

Datu pārraides kabeļi

Lietošanai ar trešo personu glikozes līmeņa asinīs
mērītājiem. Katrs mērītāja ražotājs piegādā datu
pārraides kabeli.

Piezīme: ja mērītāja ražotājs seriālā kabeļa vietā
nodrošina USB kabeli, ir jāveic ražotāja nodrošinātā
programmatūras draivera instalēšana.

Turklāt pie mērītāja ražotāja noskaidrojiet, vai ir
nodrošināta USB kabeļa draivera saderība ar izmantoto
operētājsistēmu. Daži USB draiveri var neatbilst 64 bitu
operētājsistēmām.

Līdzvērtīgas ierīces

Lai pievienotu ierīci sistēmai, sarakstā atlasiet tās izgatavotāju un modeli. Ja ierīces izgatavotājs

un modeļa nosaukums sarakstā nav atrodams, meklējiet tālāk esošajā tabulā ekvivalentu

vēlamajam.
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Ja jūsu pacients lieto kādu no šīm ierīcēm Atlasiet šo ierīci

• Bayer Ascensia™ DEX™ 2

• Bayer Ascensia™ DEXTER-Z™ II

• Bayer Glucometer™ DEXTER-Z™

• Bayer Ascensia™ ESPRIT® 2

• Bayer Glucometer™ ESPRIT®

• Bayer Glucometer™ ESPRIT® 2

Bayer Ascensia™ DEX™

Bayer Glucometer™ ELITE™ XL Bayer Ascensia™ ELITE™

Precision Xceed™ Optium Xceed™

Pasūtīšana

Lai pasūtītu Medtronic Diabetes izstrādājumus, sazinieties ar vietējo pārstāvi. Starptautiskā

kontaktinformācija atrodama šādā URL:

http://www.medtronicdiabetes.com/help/contact/locations.html

PIEZĪME: mērītājus var pasūtīt no attiecīgajiem uzņēmumiem.

Kā lietot šo rokasgrāmatu

PIEZĪME: lietotāja rokasgrāmatā ir redzami programmatūras ekrānu paraugi. Faktiski
lietotās programmatūras ekrāni var nedaudz atšķirties.

Terminu un funkciju definīcijas skatiet sadaļā “Vārdnīca”. Šajā rokasgrāmatā lietotie nosacījumi ir

definēti nākamajā tabulā.

Termins/stils Nozīme

Klikšķis Lai atlasītu objektu, kas redzams ekrānā, ar peles
kreiso pogu noklikšķiniet uz tā.

Dubultklikšķis Lai objektu ekrānā atvērtu, ar peles kreiso pogu divreiz
noklikšķiniet uz tā.

Labās pogas klikšķis Lai atvērtu citu logu vai izvēlni, ar peles labo pogu
noklikšķiniet uz objekta ekrānā.

Treknraksta teksts
Izmanto pogu, ekrānu, lauku vai izvēļņu iespēju
nosaukumiem. Piemēram: Patient > New Patient
(Pacients > Jauns pacients)

PIEZĪME: 
Nodrošina papildu informāciju par procedūru vai
darbību.

UZMANĪBU!
Brīdina par iespējamiem draudiem, kas var izraisīt
nelielus vai vidējus programmatūras vai aparatūras
bojājumus, ja netiek novērsti.

BRĪDINĀJUMS:
Brīdina par iespējamiem draudiem, kas var izraisīt nāvi
vai nopietnus ievainojumus, ja netiek novērsti. Tas var
informēt arī par iespējamām nopietnām nevēlamām
blakusparādībām un drošības riskiem.
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Lietotāja drošība

Lietošanas norādījumi

Sistēma CareLink Pro ir paredzēta lietošanai kā cukura diabēta kontroles rīks. Šīs sistēmas

uzdevums ir saņemt no insulīna sūkņiem, glikozes līmeņa asinīs mērītājiem un sistēmām glikozes

līmeņa asinīs nepārtrauktai kontrolei pārsūtīto informāciju un pārvērst to CareLink Pro ziņojumos.

Ziņojumi nodrošina informāciju, kuru var izmantot tendenču identificēšanai un ikdienas

aktivitāšu, piemēram, ogļhidrātu patēriņa, ēdienreižu laiku, insulīna padeves un glikozes rādījumu,

izsekošanai.

Brīdinājumi

• Šī sistēma ir paredzēta lietošanai veselības aprūpes speciālistiem, kuri pārzina cukura diabēta

ārstēšanu.

• Sistēmas rezultāti nav paredzēti medicīniskas konsultācijas sniegšanai, un tos nedrīkst

izmantot šādam nolūkam.

• Šis izstrādājums jālieto kopā tikai ar šajā dokumentā norādītajām atbalstītajām ierīcēm.

(Skatiet šeit: Atbalstītās ierīces lapā 2.)

• Pacientiem jāiesaka kontrolēt savu glikozes līmeni asinīs vismaz 4–6 reizes dienā.

• Pacientiem jāiesaka nemainīt ārstēšanas režīmu, nekonsultējoties ar savu veselības aprūpes

speciālistu.

• Pacientiem jāiesaka pieņemt lēmumu par ārstēšanu, pamatojoties uz veselības aprūpes

speciālista ieteikumiem un mērītāja BG rezultātiem, nevis uz glikozes sensora rezultātiem.
 
Kontrindikācijas

Programmatūru nedrīkst lietot kopā ar ierīcēm, kas nav minētas šeit: Atbalstītās ierīces lapā 2.

Programmatūru nevar arī izmantot citu veselības problēmu ārstēšanai, izņemot diabētu.

Pirms šīs programmatūras atvēršanas aizveriet visas citas pašreiz aktīvās programmatūras datorā:

• programmatūra CGMS® System Solutions™ (7310);

• programmatūra Solutions® Pumps & Meters (7311);

• programmatūra Guardian® Solutions® (7315);

• ParadigmPAL™ (7330);

• programmatūra CareLink® Personal (7333);

• programmatūra Solutions® izmantošanai ar CGMS®iPro (7319).
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2

Darba sākšana

Turpmākā informācija ir noderīga, lai sāktu darbu ar programmatūru CareLink Pro, atvērtu un

aizvērtu pacientu ierakstus un iestatītu prioritātes, kas sistēmā attiecas uz visiem pacientiem.

Pirms darba sākšanas

Ja lietojat programmatūru CareLink Pro pirmo reizi, pārliecinieties, ka ir iestatītas vispārējās

prioritātes (skatiet šeit: Vispārējas prioritātes lapā 12). Prioritātes nosaka, kā programmatūrā un

ziņojumos tiek attēloti noteikti vienumi, kā arī lietotāja izvēlēto sistēmas komunikācijas veidu ar

internetu.

Prioritātes var iestatīt jebkurā laikā. Varat arī nogaidīt, kamēr būsiet apguvis programmatūras

CareLink Pro lietošanu, un pēc tam iestatīt citas prioritātes.

Sistēmas galvenie uzdevumi

Tālāk esošajā tabulā ir minēti galvenie uzdevumi, kas būtu jāveic, pirmo reizi iestatot un

izmantojot programmatūru CareLink Pro. Tajā ir arī norādīts, kurā lietotāja rokasgrāmatas daļā ir

apskatīts katrs uzdevums.

Darbība Vieta

Iepazīstieties ar CareLink Pro lietotāja saskarni. Sistēmas navigācija lapā 8

Definējiet klīnikā lietojamās kopējās sistēmas opcijas. Sistēmas prioritāšu iestatīšana lapā 11

Izveidojiet katram pacientam profilu. Jaunu profilu pievienošana lapā 20

Izveidojiet saiti ar savu pacientu CareLink Personal
kontiem. Saites izveidošana ar CareLink Personal kontu lapā 21

Pievienojiet pacienta profilam pacienta sūkni un
mērītājus. Ierīces pievienošana lapā 28

Nolasiet pacienta sūkņa un mērītāju rādījumus. Ierīces datu nolasīšana lapā 33

Iestatiet un ģenerējiet ziņojumus katram pacientam. Ziņojumu izveidošana lapā 37
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Darbība Vieta

Regulāri izveidojiet CareLink Pro datubāzes dublējumu. Datubāzes dublēšana lapā 47

Atjauniniet programmatūru CareLink Pro. Programmatūras atjauninājumu lietošana lapā 46

Sistēmas navigācija

Pirms darba sākšanas ar programmatūru CareLink Pro iepazīstieties ar lietotāja saskarni. Lietotāja

saskarnē ir izvēlnes, rīkjosla, navigācijas josla, darbvietas un logs Guide Me (Vadi mani).

Programmatūras CareLink Pro atvēršana

1 Veiciet dubultklikšķi uz programmatūras CareLink Pro ikonas  sava datora darbvirsmā vai

Windows izvēlnes Start (Sākt) programmu sarakstā atlasiet Medtronic CareLink Pro.

Ja saskaņā ar jūsu klīnikas noteikumiem tiek prasīts ievadīt paroli, tiek parādīts pieteikšanās

ekrāns.

a. Ievadiet savu paroli laukā Password (Parole).

PIEZĪME: paroles pieprasīšana ir izvēles iespēja, kas tiek iestatīta instalēšanas
procesā.

b. Noklikšķiniet uz LOGIN (Pieteikties).

Tiek parādīts startēšanas ekrāns.

2 Lai sāktu jauna pacienta ierakstu, noklikšķiniet uz New Patient  (Jauns pacients). Lai atvērtu

tāda pacienta ierakstu, kas jau ir sistēmas pacientu sarakstā, noklikšķiniet uz Open Patient
(Atvērt pacientu).

Darbvietas

Ja pacienta ieraksts ir atvērts, varat noklikšķināt uz vienas no navigācijas joslas pogām, lai tiktu

parādīta atbilstošā darbvieta. Izmantojiet šīs darbvietas, lai ievadītu vai atlasītu informāciju, kas

nepieciešama, lai veiktu ar šo pacientu saistītos CareLink Pro uzdevumus.

Profile (Profils): ļauj apstrādāt saglabāto pacienta
informāciju, piemēram, vārdu un dzimšanas datumu.
Šajā darbvietā iespējams arī izveidot saiti ar pacienta
CareLink Personal kontu.

Devices (Ierīces): ļauj saglabāt informāciju, kas
nepieciešama, lai nolasītu pacienta ierīču mērījumus.

Reports (Ziņojumi): ļauj atlasīt parametrus un
izvēlēties, kādus ziņojumus par pacientu ģenerēt.

Kamēr pacientam nav pievienots un saglabāts profils, šim pacientam ir pieejama tikai darbvieta

Profile (Profils). Kamēr pacienta profilam nav pievienotas ierīces, šim pacientam ir pieejama tikai

darbvieta Profile (Profils) un Devices (Ierīces).
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Rīkjosla

Programmatūras CareLink Pro rīkjosla nodrošina iespēju ātri piekļūt bieži lietotām funkcijām.

Rīkjoslai ir šādas pogas.

Poga Nosaukums Funkcionalitāte

Add Patient (Pievienot pacientu)
Tiek atvērta darbvieta Profile
(Profils), ļaujot sistēmā pievienot
jaunu pacienta ierakstu.

Open Patient (Atvērt pacienta
ierakstu)

Tiek atvērta pacienta pārlūktabula,
kurā var izvēlēties un apskatīt
esošo pacienta ierakstu.

Guide Me (Vadi mani)

Tiek attēlots vai paslēpts logs
Guide Me (Vadi mani).
Noklikšķiniet, lai iegūtu sistēmas
ieteikumus konteksta izpratnei.

Pacienta cilnes

Kad ir atvērts pacienta ieraksts, rīkjoslā tiek parādīta cilne ar pacienta vārdu. Ja cilne ir aktīva, arī

pacienta ieraksts un darbvieta ir aktīva, tādēļ ir iespējams veikt ar pacientu saistītos CareLink Pro

uzdevumus.

Lai pacienta ieraksta lauks kļūtu aktīvs un ar to varētu strādāt, noklikšķiniet uz šī pacienta cilnes.

Lai aizvērtu pacienta ierakstu, noklikšķiniet cilnē uz pogas Close  (Aizvērt) .

Funkcija Guide Me (Vadi mani)

Funkcija Guide Me (Vadi mani) ir pieejama visā programmatūras CareLink Pro lietošanas procesā.

Tā atver logu ar kontekstā saprotamiem padomiem un ieteikumiem par darbībām, kuras

iespējams veikt aktīvajā sistēmas daļā. Funkcijas Guide Me (Vadi mani) logos var būt iekļautas arī
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saites >>learn more  (uzziniet vairāk). Noklikšķinot uz šīm saitēm, tiek atvērtas atbilstošās

tiešsaistes palīdzības sadaļas ar plašāku informāciju. Funkcija Guide Me (Vadi mani) ir aktīva pēc

noklusējuma. Taču to jebkurā laikā var atslēgt.

Funkcijas Guide Me (Vadi mani) ieslēgšana un izslēgšana

Lai funkciju Guide Me (Vadi mani) ieslēgtu vai izslēgtu, rīkojieties šādi:

• noklikšķiniet uz pogas Guide Me  (Vadi mani) vai 

• atlasiet Help > Guide Me  (Palīdzība > Vadi mani).

Pacienta ierakstu atvēršana

Vienlaicīgi var atvērt ne vairāk kā sešus pacienta ierakstus. Informāciju, par to kā rīkoties, ja vēl

nav izveidots neviens pacienta profils, skatiet šeit: Jaunu profilu pievienošana lapā 20.

1 Atlasiet File > Open Patient (Fails > Atvērt pacienta ierakstu) vai noklikšķiniet uz pogas Open

Patient  (Atvērt pacienta ierakstu).  Tiek parādīts pacientu saraksts, kas ir līdzīgs tālāk

redzamajam.
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PIEZĪME: ja ir redzams paziņojums, ka atvērts pārāk daudz pacientu ierakstu,
noklikšķiniet uz OK (Labi), aizveriet ierakstu un turpiniet darbu.

2 Sarakstā atrodiet pacientu, ierakstot pacienta vārda daļu vai visu vārdu laukā Find a Patient
(Atrast pacientu). Kad pacienta ieraksts tiek iezīmēts, noklikšķiniet uz OPEN (Atvērt), veiciet

dubultklikšķi uz ieraksta vai nospiediet ENTER (Ievadīt). Sarakstā var pārvietoties, arī

izmantojot tastatūras augšupvērsto vai lejupvērsto bultiņu.

Tiek parādīta pacienta darbvieta Devices (Ierīces) (ja ierīces vēl nav pievienotas) vai Reports
(Ziņojumi).

3 Lai skatītu pacienta darbvietu Profile  (Profils), navigācijas joslā noklikšķiniet uz pogas Profile

(Profils) .

Pacienta ierakstu aizvēršana

1 Pārliecinieties, vai pacienta ieraksts, kuru vēlaties aizvērt, ir aktīvs (cilne izcelta).

2 Veiciet vienu no šīm darbībām:

a. atlasiet File > Close Patient  (Fails > Aizvērt pacienta ierakstu);

b. pacienta cilnē noklikšķiniet uz pogas Close  (Aizvērt) ;

c. nospiediet taustiņu kombināciju Ctrl+F4.

Sistēmas prioritāšu iestatīšana

Sistēma piemēro šīs prioritātes visiem pacientiem. Informāciju par prioritātēm, kas ietekmē tikai

atsevišķu pacientu ierakstus, skatiet šeit: Ziņojuma iestatījumu pārbaude lapā 40.

Prioritātes tiek parādītas šādās grupās:

• Vispārējas

- Glikozes vienības

- Ogļhidrātu vienības

- Komunikācija

- Traucējummeklēšana

• Pacienta profils

- Atlasiet un kārtojiet datu laukus pacientu profilos.

• Pacienta informācijas atrašana

- Izvēloties opciju Open Patient (Atvērt pacienta ierakstu), lai skatītu pacientu sarakstu,

pārveidojiet un mainiet lauku parādīšanas secību.

• Ziņojuma ģenerēšana

- Izvēlieties datu laukus, kurus vēlaties redzēt, tabulā Data (Dati) atlasot ziņojuma Daily

Detail (Ikdienas detalizēta informācija) ievadi.
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Vispārējas prioritātes

Izmantojiet cilni General (Vispārīgi), lai noteiktu, kā programmatūrā tiks attēlota noteikta veida

informācija, un nosakiet savas ārējās komunikācijas prioritātes.

1 Ja cilne General (Vispārīgi) vēl nav aktīva, noklikšķiniet uz tās.

2 Atlasiet Tools > Options  (Rīki > Iespējas). Tiek parādīts šāds logs.

3 Lai atlasītu nepieciešamās vērtības opciju pogu, noklikšķiniet uz tās:

- Glucose Units  (Glikozes vienības): mmol/l vai mg/dl

- Carbohydrate Units  (Ogļhidrātu vienības): grami vai apmaiņas

a. Atlasot opciju Exchanges  (Apmaiņa), lai norādītu Carbohydrate Units  (Ogļhidrātu

vienības), ievadiet atbilstošu skaitli laukā grams are equal to 1 Exchange  (grami, kas

līdzvērtīgi 1 apmaiņai).

4 Lai atlasītu vai notīrītu izvēles rūtiņu, noklikšķiniet sadaļā Chart Options > Overview Report

(Diagrammas iespējas > Pārskata ziņojums). Ja izvēles rūtiņa ir atlasīta, lietojumprogramma ar

līnijām savienos BG mērījumus diagrammā Meter Glucose Overlay (Glikozes līmeņa mērījumu

pārklājums). (Šī diagramma tiek parādīta sensora un mērītāja pārskata ziņojumā.)

5 Noklikšķiniet, lai atlasītu izvēles rūtiņu (iespējotu) vai lai to notīrītu (atspējotu) turpmākām

komunikācijas prioritātēm.

PIEZĪME: iestatot komunikācijas prioritātes, ievērojiet savas klīnikas vai IT nodaļas
ieteikumus.
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- Programmatūras atjauninājumu automātiska pārbaude: ja ir atlasīta šī prioritāte,

ikreiz, kad ir pieejams programmatūras atjauninājums, tiek nosūtīts paziņojums katrai

sistēmai, kurā darbojas programmatūra CareLink Pro. Aktīvajam lietotājam ir iespēja

lejupielādēt un instalēt atjauninājumus. Lai tas nenotiktu un varētu kontrolēt

programmatūras atjauninājumus, izvēles rūtiņa ir jānotīra.

- Veikt sinhronizāciju ar Medtronic CareLink® Personal:  ja vēlaties, lai, katru reizi

atverot pacienta profilu, sistēmā automātiski tiek sinhronizēti viņa CareLink Personal

konta dati, atlasiet šo izvēles rūtiņu. Ja izvēles rūtiņa ir notīrīta, CareLink Personal dati

katram pacientam ir jāsinhronizē manuāli.

6 Noklikšķiniet sadaļā Troubleshooting (Traucējummeklēšana), lai atlasītu vai notīrītu izvēles

rūtiņu. Ja izvēles rūtiņa ir atlasīta, lietojumprogrammā tiks saglabāti ierīces rādījumu ieraksti

traucējummeklēšanas vajadzībām.

7 Lai saglabātu vispārējās prioritātes, noklikšķiniet uz OK (Labi).

Pacienta profila prioritātes

Šis ir vispārīgs iestatījums, kas nosaka jūsu profilu saturu. Laukus darbvietā Profiles (Profili) var

pielāgot, iekļaujot informāciju, kas jūsu klīnikā ir svarīgākā. Varat pievienot vai dzēst laukus,

izveidot savus pielāgotos laukus un noteikt kārtību, kādā lauki tiek parādīti logā.

1 Atlasiet Tools > Options  (Rīki > Iespējas).

2 Noklikšķiniet uz cilnes Patient Profile  (Pacienta profils). Tiek parādīts šāds logs.

PIEZĪME: izmantojiet izvēles rūtiņas, lai atlasītu tos laukus, kurus vēlaties šajā profilā.

Laukus vēlamajā secībā novietojiet, izmantojot augšupvērstās vai lejupvērstās bultiņas.

Datu lauku izvēlēšanās

1 Pievienojiet vēlamos laukus, izmantojot izvēles rūtiņas.

CareLink Pro Lietošanas instrukcija   Darba sākšana 13



PIEZĪME: nav iespējams dzēst vārdu un uzvārdu.

2 lai profilā dzēstu lauku, notīriet attiecīgo izvēles rūtiņu.

3 Lai lauku apzīmētu kā nepieciešamu, slejā Required  (Nepieciešams) atlasiet attiecīgo izvēles

rūtiņu. Visi nepieciešamie lauki ir jāaizpilda pirms profila izveidošanas.

Individuālu lauku pievienošana

1 Atlasiet izvēles rūtiņu pa kreisi no tukša individuālā lauka.

2 Ievadiet lauka nosaukumu (piemēram, Ārkārtas saziņa). Ar šādu nosaukumu lauks tiks

parādīts pacienta profilā.

3 Lai lauku apzīmētu kā nepieciešamu, slejā Required  (Nepieciešams) atlasiet attiecīgo izvēles

rūtiņu.

PIEZĪME: Lai profilā dzēstu pielāgoto lauku, notīriet izvēles rūtiņu blakus 

attiecīgajam(-ajiem) laukam(-iem).

Datu lauku secības maiņa

Atlasiet lauku, kuru vēlaties pārvietot, un noklikšķiniet uz augšupvērstās vai lejupvērstās bultiņas

, lai to izdarītu. (Augšpuses un apakšpuses bultiņas pārvieto lauku no saraksta augšas uz leju

vai otrādi.)

Pacienta profila prioritāšu noformēšana

Kad sarakstā Field Order (Lauku secība) visi nepieciešamie lauki ir pareizajā secībā, noklikšķiniet uz

OK (Labi).

Tagad pacienta profilā izvēlētie lauki ir vēlamajā secībā.

Pacienta informācijas meklēšanas prioritātes

Tabula Patient Lookup (Pacienta informācijas meklēšana) tiek izmantota, lai meklētu un atvērtu

pacienta ierakstus. Tabulā ir informācija par visiem datubāzē esošajiem pacientiem, un tā

nodrošina pacienta profila informācijas atpazīšanu. Jums ir iespēja noteikt, kādu informāciju

attēlot šajā tabulā un kādā kārtībā parādīt slejas. Lai pielāgotu tabulu Patient Lookup (Pacienta

informācijas meklēšana), veiciet tālāk norādītās darbības.

1 Atlasiet Tools > Options  (Rīki > Iespējas).
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2 Noklikšķiniet uz cilnes Patient Lookup (Pacienta informācijas meklēšana). Tiek parādīts šāds

logs.

PIEZĪME: izmantojiet izvēles rūtiņas, lai atlasītu datus, ko vēlaties redzēt tabulā Patient
Lookup (Pacienta informācijas meklēšana). Slejas vēlamajā secībā novietojiet,
izmantojot augšupvērstās un lejupvērstās bultiņas.

Parādāmo datu izvēlēšanās

Lai atlasītu datu veidu, ko vēlaties atvērt, vai notīrītu tos datu veidus, kurus nevēlaties attēlot

tabulā Patient Lookup (Pacienta informācijas meklēšana), izmantojiet izvēles rūtiņas.

Sleju secības maiņa

Lai tabulā Patient Lookup (Pacienta informācijas meklēšana) mainītu sleju secību, atlasiet

pārvietojamo sleju un noklikšķiniet uz augšupvērstajām vai lejupvērstajām bultiņām. 

(Izmantojot augšupvērstās vai lejupvērstās bultiņas, datu sleju sarakstā var pārvietot no augšas uz

leju vai otrādi.)

Saraksta Column Display Order (Sleju rādīšanas secība) augšpusē esošā datu sleja tiek parādīta

tabulas Patient Lookup (Pacienta informācijas meklēšana) pirmajā slejā. Apakšā esošā datu sleja

tiek parādīta tabulas pēdējā slejā.

Pacienta informācijas atrašanas prioritāšu noformēšana

Kad sarakstā Column Display Order (Sleju rādīšanas secība) visi nepieciešamie dati ir pareizā

secībā, noklikšķiniet uz OK (Labi).

Tagad tabulā Patient Lookup (Pacienta informācijas meklēšana) dati un sleju secība ir izvēlētajā

secībā.
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Ziņojuma ģenerēšanas prioritātes

Tabula Data (Dati) tiek parādīta logā Select and Generate Reports (Ziņojumu atlase un

ģenerēšana). Šo tabulu izmanto, ģenerējot ziņojumus. Tajā ir apkopota informācija, kas ikdienā

tiek iegūta no pacienta ierīcēm un no programmatūras CareLink Personal konta, ja tas ir

pieejams. Šajā tabulā apkopotie dati palīdz noteikt, kurās dienās ir nepieciešams ģenerēt

ziņojumu Daily Detail (Ikdienas detalizēta informācija). Tas palīdz arī izlemt, kuru no pārējiem

ziņojumiem vajadzētu ģenerēt.

Lai noteiktu, kuri dati jūsu klīnikai ir atbilstošāki, klīnika var pielāgot tabulā attēlojamos datus,

tostarp arī kārtību, kādā tie tiek parādīti.

PIEZĪME: informāciju par prioritāšu piemērošanu tabulai Data (Dati) ziņojuma izveidošanas

procesā skatiet šeit: Ziņojuma veida un iekļaujamo datumu atlase lapā 41.

1 Atlasiet Tools > Options  (Rīki > Iespējas).

2 Noklikšķiniet uz cilnes Report Generation (Ziņojumu ģenerēšana). Tiek parādīts šāds logs.

Parādāmo datu izvēlēšanās

Lai izvēlētos datu veidu, ko vēlaties parādīt tabulā Data (Dati) vai dzēst no tabulas, izmantojiet

izvēles rūtiņas.

Iekļaušanai tabulā Data (Dati) ir pieejama tālāk sniegtā informācija.

Slejas nosaukums Definīcija

№ of Meter Readings (Mērītāja rādījumu skaits) Pievienotās ierīces noteiktā datumā veikto mērījumu
skaits.

Meter Readings Average (Mērītāja mērījumu vidējā
vērtība)

Vidējā vērtība pievienotās ierīces veiktajiem
mērījumiem, nosakot glikozes līmeni asinīs.
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Slejas nosaukums Definīcija

Sensor Duration (Sensora darbības laiks)
Laika apjoms, kurā noteiktajā datumā tika ierakstīti
sensora iegūtie dati. Vērtības — (bez vērtības), 
0:05–24:00.

Sensor Average (Sensora datu vidējā vērtība) Noteiktajā datumā sensora veikto mērījumu vidējā
vērtība.

Highest Reading (Augstākais mērījums) Noteiktajā datumā iegūtais glikozes līmeņa asinīs
augstākais mērījums (iegūts no sensora vai mērītāja).

Lowest Reading (Zemākais mērījums) Noteiktajā datumā iegūtais glikozes līmeņa asinīs
zemākais mērījums (iegūts no sensora vai mērītāja).

Avg AUC Below Target (Vidējais AUC zem mērķa)
Vidējais apgabals zem līknes (Area Under the Curve —
AUC) ir zemāks par pacientam noteikto mērķa
diapazonu.

Avg AUC Above Target (Vidējais AUC virs mērķa) Vidējais apgabals zem līknes (Area Under the Curve) ir
augstāks par pacientam noteikto mērķa diapazonu.

Total Carbs (Kopējais ogļhidrātu daudzums)

Visu ogļhidrātu kopējais daudzums (atkarībā no
izmantotās mērījumu vienības, noapaļots līdz pilnam
gramam vai 0,1 apmaiņas vērtībai), par kuru ziņots
noteiktajā dienā ar Bolus Wizard gadījumiem vai
ogļhidrātu atzīmēm uz sūkņa vai monitora Guardian.

Suspend Duration (Apturēšanas ilgums) Laiks, cik ilgi noteiktajā datumā tika apturēta sūkņa
darbība. Vērtības — (nav datu), 0:01–24:00.

№ of Rewinds (Uzvilkšanas reižu skaits) Norāda skaitu, cik reizes noteiktajā datumā ierīce ir
uzvilkta.

№ of Primes (or Fills) (Uzpildīšanas reižu skaits) Skaits, cik reizes noteiktajā datumā ir veiktas atzīmes
par insulīna uzpildīšanu.

Prime (or Fill) Volume (U) (Iepildītais daudzums (U)) Noteiktajā datumā iepildīšanai izmantotais kopējais
insulīna daudzums.

Total Insulin (U) (Kopējais insulīna daudzums (U)) Noteiktajā datumā ievadītais un sūkņa nomērītais
kopējais insulīna daudzums.

Total Basal (U) (Kopējais bazālā insulīna daudzums (U))
Noteiktajā datumā ievadītā bazālā insulīna daudzums
(kopējais ievadītā insulīna daudzums, kas ir mazāks par
visu ievadīto bolus devu summu).

Total Bolus (U) (Kopējā bolus deva (U)) Noteiktajā datumā ievadītais un sūkņa atzīmētais
kopējais insulīna daudzums, kas sadalīts bolus devās.

Basal % (Procentuālā (%) bazālā deva) Norāda bazālās insulīna devas attiecību pret kopējo
insulīna daudzumu (pilnās % vērtībās).

Bolus % (Procentuālā (%) bolus deva) Norāda insulīna bolus devas attiecību pret kopējo
insulīna daudzumu (pilnās % vērtībās).

№ of Boluses (Bolus devu skaits) Noteiktajā datumā atzīmēto bolus devu skaits.

Bolus Wizard Events (Bolus Wizard gadījumi) Norāda skaitu, cik reizes noteiktajā datumā ierīce ir
atzīmējusi Bolus Wizard gadījumus.

Bolus Wizard Overrides (Bolus Wizard pārsniegtās
devas)

Gadījums skaits, kuros Bolus Wizard ievadītā insulīna
deva ir atšķīrusies no ieteiktās devas.

№ of Meal Boluses (Ēdienreižu bolus devu skaits)
Noteiktajā datumā atzīmēto gadījumu skaits, kuros
Bolus Wizard deva kopā ar uzņemtajiem ogļhidrātiem
ir bijusi lielāka par nulli.

№ of Correction Boluses (Bolus devu korekciju skaits) Noteiktajā dienā atzīmēto gadījumu skaits, kuros Bolus
Wizard devu korekcijas ir bijušas lielākas par nulli.

№ of Manual Boluses (Manuālo bolus devu skaits) Noteiktajā datumā atzīmētais skaits ievadītajām bolus
devām, kurām nav izmantots Bolus Wizard.
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Sleju secības maiņa

Lai tabulā Data (Dati) mainītu sleju secību, atlasiet pārvietojamo sleju un noklikšķiniet uz

augšupvērstās vai lejupvērstās bultiņas.  (Izmantojot augšējās un apakšējās bultiņas, datu

sleja tiek pārvietota no saraksta augšas uz leju vai otrādi.)

PIEZĪME: saraksta Column Order (Sleju secība) augšpusē esošie ieraksti tiek parādīti tabulas
Data (Dati) pirmajā slejā. Apakšā esošie ieraksti tiek parādīti tabulas Data (Dati) pēdējā
slejā.

Ziņojuma ģenerēšanas prioritāšu noformēšana

Kad sarakstā Column Order (Sleju secība) visi nepieciešamie dati ir pareizā secībā, noklikšķiniet uz

OK (Labi).

Tagad dati un sleju secība tabulā Data (Dati) ir izvēlētajā secībā.

CareLink Pro Lietošanas instrukcija   Darba sākšana 18



3

Darbvieta Profile (Profils)

Profils ir līdzīgs medicīniskās kartes titullapai. Tajā ir saglabāti tādi dati par pacientu kā viņa vārds

un dzimšanas datums. Profils jāizveido, pirms ierīces datu vākšanas un to izmantošanas ārstēšanas

ziņojumos.

Darbvietā Profile (Profils) iespējams arī iestatīt saiti uz pacienta CareLink Personal kontu. Kad saite

ir izveidota, CareLink Personal kontā saglabātos pacienta datus jebkurā laikā var nolasīt bez

pacienta klātbūtnes.

Pirms darba sākšanas

Pacientu profilus var būt nepieciešams pielāgot tā, lai tie saturētu tikai tos datus, ko vēlaties

apkopot. Lai uzzinātu vairāk, skatiet Pacienta profila prioritātes lapā 13.

Iestatot saiti uz pacienta CareLink Personal kontu, ir nepieciešams arī lietotājvārds un parole. Lai

iegūtu šos datus, ir nepieciešama pacienta klātbūtne.
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Jaunu profilu pievienošana

Katru reizi, kad sistēmā CareLink Pro pievienojat jauna pacienta datus, vispirms ir jāaizpilda

pacienta profils.

1 Atlasiet File > New Patient (Fails > Jauns pacients) vai noklikšķiniet uz pogas Add Patient

(Pievienot pacientu). 

Tiek atvērta darbvieta Profile  (Profils).

PIEZĪME: lai pacienta profilā pievienotu vai mainītu laukus, noklikšķiniet uz customize

fields (pielāgot laukus). Skatiet šeit: Pacienta profila prioritātes lapā 13.

2 Aizpildiet laukus sadaļā Patient Profile  (Pacienta profils).

3 Noklikšķiniet uz SAVE (Saglabāt).

Jaunais pacienta profils ir pievienots programmatūras CareLink Pro datubāzei. Tiek parādīts

paziņojums, kas apstiprina, ka profils ir saglabāts.

Nepieciešamo lauku aizpildīšana

1 Ja, saglabājot pacienta profilu, nepieciešamie lauki nav aizpildīti, blakus attiecīgajam laukam

tiek parādīts paziņojums. Profilu nav iespējams saglabāt, kamēr laukā nav ierakstu.

2 Aizpildiet šo lauku.

3 Noklikšķiniet uz SAVE (Saglabāt).

4 Kad tiek parādīts apstiprinājuma paziņojums, noklikšķiniet uz OK (Labi).

Pacientu profilu rediģēšana

1 Pacienta darbvietai Profile  (Profils) ir jābūt atvērtai.

2 Noklikšķiniet uz EDIT  (Rediģēt).

3 Rediģējiet datus sadaļā Patient Profile  (Pacienta profils) pēc vajadzības.

4 Noklikšķiniet uz SAVE (Saglabāt).

Tiek parādīts paziņojums, kas apstiprina, ka profils ir saglabāts.

Pacienta datu dzēšana no sistēmas

1 Pacienta darbvietai Profile  (Profils) ir jābūt atvērtai.

2 Pārliecinieties, ka tieši šī pacienta datus vēlaties dzēst. Dzēšot pacienta profilu, no

programmatūras CareLink Pro datubāzes tiek noņemti arī visi pacienta dati un tos vairs nav

iespējams atgūt.

3 Noklikšķiniet uz >> delete patient record (dzēst pacienta ierakstu) virs profila

sinhronizēšanas sadaļas.

Tiek parādīts brīdinājuma paziņojums, ka, dzēšot ierakstu, tiks izdzēsti visi pacienta dati.
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4 Lai izdzēstu pacienta ierakstu, noklikšķiniet uz Yes (Jā).

Saites izveidošana ar CareLink Personal kontu

Ja pacients ir devis atļauju, varat iestatīt saiti uz viņa CareLink Personal kontu. Šis tīmekļa rīks

pacientiem ļauj augšupielādēt un uzglabāt ierīces iegūtos datus, kā arī ģenerēt dažādus

ziņojumus par ārstēšanas gaitu.

Kad ir izveidota saite uz pacienta CareLink Personal kontu, var nolasīt viņa kontā saglabātos

ierīces datus. Šī informācija ir noderīga, lai veidotu programmatūras CareLink Pro ziņojumus par

ārstēšanas gaitu starp pacienta vizītēm. Tādējādi nav nepieciešams nolasīt pacienta ierīces

rādījumus vizītes laikā.

Ja pacientam vēl nav CareLink Personal konta, varat viņam nosūtīt e-pasta ziņojumu ar aicinājumu

izveidot šādu kontu.

Saites izveidošana ar esošu kontu

PIEZĪME: šīs darbības ir izpildāmas pacienta klātbūtnē.

1 Ir jābūt izveidotam savienojumam ar internetu.

2 Atveriet pacienta darbvietu Profile  (Profils).

3 Visiem nepieciešamajiem laukiem sadaļā Patient Profile  (Pacienta profils) ir jābūt

aizpildītiem.

4 Noklikšķiniet uz LINK TO EXISTING ACCOUNT  (Izveidot saiti ar esošu kontu).

Tiek parādīts CareLink Personal konta ekrāns Log In (Pieteikties).

5 Lūdziet pacientam izdarīt tālāk norādītās darbības.

a. Ierakstīt savu lietotājvārdu un paroli.

b. Noklikšķināt uz Sign In (Reģistrēties).

Ņemot vērā pacienta reģistrācijas valodas un reģiona iestatījumus, tiek parādīta lapa Grant
Access  (Piekļuves piešķiršana).

6 Lūdziet pacientam izdarīt tālāk norādītās darbības.

a. Izlasīt Terms of Use  (Lietošanas nosacījumi).

b. Atlasīt izvēles rūtiņu blakus laukam I agree to the Terms of Use above...  (Piekrītu

iepriekš minētajiem lietošanas nosacījumiem).

c. Noklikšķināt uz Grant Access  (Piekļuves piešķiršana).

d. Informēt jūs, kad tiek parādīta lapa Thank You  (Paldies).

7 Ja nepieciešams, varat izdrukāt lietošanas nosacījumus, lai iedotu tos pacientam. Lai to

izdarītu, noklikšķiniet uz pogas Print  (Drukāt). Tagad ir izveidota saite uz pacienta CareLink

Personal kontu.
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E-pasta uzaicinājuma nosūtīšana

Lai nosūtītu pacientam e-pasta uzaicinājumu, izveidot CareLink Personal kontu, veiciet tālāk

minētās darbības.

1 Atveriet pacienta darbvietu Profile  (Profils).

2 Pārliecinieties, ka visi nepieciešamie lauki sadaļā Patient Profile  (Pacienta profils) ir

aizpildīti.

3 Noklikšķiniet uz SEND E-MAIL INVITATION TO PATIENT (Nosūtīt e-pasta uzaicinājumu

pacientam).

4 Pārliecinieties, ka lauki Patient Name (Pacienta vārds), E-mail Address  (E-pasta adrese) un

Language  (Valoda) ir pareizi aizpildīti.

5 Noklikšķiniet uz SEND (Sūtīt).

Pacienta profila statusa apgabalā tiek parādīts e-pasta nosūtīšanas apstiprinājums.

Datu iegūšana no saistītā konta

Ja ir izveidota saite uz pacienta CareLink Personal kontu, no tā tiek automātiski nosūtīti jaunie

dati ikreiz, kad tiek atvērts pacienta profils programmatūrā CareLink Pro.

PIEZĪME: lai nodrošinātu datu nosūtīšanu automātiski, dodieties uz Tools > Options >
General (Rīki > Iespējas > Vispārīgi) un atlasiet izvēles rūtiņu blakus laukam Synchronize
with CareLink Personal (Veikt sinhronizāciju ar CareLink Personal kontu).

Lai iegūtu pacienta CareLink Personal konta datus, katru reizi atverot pacienta profilu, veiciet

tālāk norādītās darbības.

1 Pārliecinieties, ka pacienta darbvieta Profile  (Profils) ir atvērta un ir aktīvs interneta

savienojums.

2 Atlasiet Tools > Synchronize Patient Data  (Rīki > Sinhronizēt pacienta datus).

Sinhronizācijas ikona  pacienta cilnē griežas. Kad ikona apstājas, process ir pabeigts.
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PIEZĪME: ja pacients vairs nevēlas kopīgot ar jums savus CareLink Personal konta datus,
tiek parādīts paziņojums, informējot jūs par to.

3 Visi papildu dati, kas iegūti no CareLink Personal konta, būs redzami pacienta ziņojumos.

Pacienta CareLink Personal konta atsaistīšana no CareLink Pro

Pacienta CareLink Personal kontu var atsaistīt no CareLink Pro. Šī opcija ir pieejama tikai tad, ja

ir izveidota saite uz pacienta kontu. Tādējādi programmatūrai CareLink Pro turpmāk tiek liegta

iespēja iegūt datus no pacienta CareLink Personal konta. Taču tas neietekmē pacienta darbu ar

CareLink Personal kontu.

1 Atveriet pacienta ierakstu un piekļūstiet darbvietai Profile  (Profils).

2 Noklikšķiniet uz UNLINK ACCOUNT (Noņemt saiti uz kontu).

3 Kad tiek parādīts apstiprinājuma paziņojums, noklikšķiniet uz Yes (Jā). Pacienta personiskais

profils vairs nav saistīts ar programmatūru CareLink Pro.

Statuss tiek mainīts uz Not linked (Nesaistīts), un tiek parādītas pogas LINK TO EXISTING
ACCOUNT (Veidot saiti uz esošo kontu) un SEND E-MAIL INVITATION TO PATIENT  (Nosūtīt

e-pasta uzaicinājumu pacientam).
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4

Aparatūras iestatīšana

Lai nolasītu datus tieši no ierīces, ir jābūt pieejamai pacienta ierīcei un visiem kabeļiem vai sakaru

ierīcēm, kas nepieciešamas, lai pārsūtītu datus uz datoru.

Ja pacienti ir augšupielādējuši ierīču datus savos CareLink Personal kontos, pastāv iespēja datus

iegūt, izveidojot saiti uz pacienta kontu. Lai izveidotu saiti ar pacienta CareLink Personal kontu,

skatiet informāciju šeit: Saites izveidošana ar CareLink Personal kontu lapā 21.

Ierīču pievienošana

Apskatiet kopējo zīmējumu, lai gūtu vispārīgu ieskatu, kā jāuzstāda ierīces, lai tās komunicētu ar

datoru. Attēlos ir redzamas konkrētas ierīču komunikāciju detaļas.

Lai iegūtu papildinformāciju, ierīču nolasīšanas laikā izpildiet programmatūrā CareLink Pro

sniegtos norādījumus.
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Pārskats par aparatūras iestatīšanu

Tālāk esošajā paraugā ir attēlota sūkņa komunikācijai ar datoru izmantotā CareLink USB ierīce.

Atbalstīto sakaru ierīču sarakstu skatiet šeit: Atbalstītās ierīces lapā 2.

Seriālo un USB kabeļu savienojumu piemēri:
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Papildu ComLink savienojums izmantošanai ar Paradigm sērijas sūkni:

Papildu ierīce Com-Station izmantošanai ar sūkni Medtronic MiniMed 508:
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5

Darbvieta Devices (Ierīces)

Informācija, kas ir nepieciešama, lai nolasītu pacienta ierīces datus, piemēram, ražotājs, modelis

un sērijas numurs, ir saglabāta darbvietā Devices (Ierīces). Tādēļ tā nav jāievada ikreiz, kad nolasāt

ierīces datus.

Darbvietā Devices (Ierīces) informācija par ierīcēm tiek glabāta vienā no diviem sarakstiem —

Active Devices (Aktīvās ierīces) vai Inactive Devices (Neaktīvās ierīces). Pievienojot ierīci,

informācija par to tiek automātiski ievietota sarakstā Active Devices (Aktīvās ierīces). Datus var

nolasīt tikai no tām ierīcēm, kas ir redzamas sarakstā Active Devices (Aktīvās ierīces). Tās,

visticamāk, būs ierīces, ko pacients lieto pašreiz.

Citas pacientam piederošās ierīces, kas pašlaik netiek lietotas, var tikt saglabātas sarakstā Inactive

Devices (Neaktīvās ierīces). Tādējādi informācija tiek saglabāta failā. Šīs ierīces var aktivizēt jebkurā

laikā.
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Pirms darba sākšanas

Lai varētu atvērt pacienta darbvietu Devices (Ierīces), sistēmā ir jābūt saglabātam pacienta

profilam. Skatiet šeit: Jaunu profilu pievienošana lapā 20.

Lai varētu pievienot ierīci vai nolasīt datus tieši no tās, ierīcei ir jākomunicē ar datoru. Lai uzzinātu,

kā ierīces iestatīt, lai tās varētu komunicēt ar datoru, skatiet šeit: Ierīču pievienošana lapā 24.

Ierīces pievienošana

Informāciju par vēl nepievienotu ierīci var iegūt no pacienta CareLink Personal konta. Šīs ierīces

tiek automātiski pievienotas brīdī, kad tiek veikta CareLink Personal konta un programmatūras

CareLink Pro datu sinhronizēšana.

PIEZĪME: vienam pacientam aktīvs var būt tikai viens sūknis. Jauna sūkņa pievienošana

esošo sūkni pārvietos uz neaktīvo ierīču sarakstu.

Sūkņa Medtronic vai monitora Guardian pievienošana

1 Pievienojamajai ierīce ir jābūt iestatītai, lai komunicētu ar datoru. (Informāciju par

savienojuma izveidošanu skatiet šeit: Ierīču pievienošana lapā 24.)

2 Noklikšķiniet uz pacienta cilnes vai veiciet dubultklikšķi uz pacienta vārda tabulā Patient

Lookup (Pacienta informācijas meklēšana).

3 Lai piekļūtu pacienta darbvietai Devices (Ierīces), noklikšķiniet uz Devices (Ierīces) .

4 Noklikšķiniet uz ADD DEVICE  (Pievienot ierīci).

5 Atlasiet Medtronic Pump/Guardian (Medtronic sūknis/Guardian). Tiek parādīts vednis Add
Medtronic Pump/Guardian  (Pievienot Medtronic sūkni/Guardian).

PIEZĪME: sūkņa modelis ir redzams uz sūkņa aizmugures vai tiek parādīts sūkņa statusa

ekrānā.

6 Lai norādītu pievienojamo ierīci, izvēlieties opciju pogu.
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Ja ir atlasīta opcija MiniMed 508 pump (Sūknis MiniMed 508), veiciet 9. darbību.

7 Noklikšķiniet uz NEXT  (Tālāk). Tiek parādīta lapa Serial Number  (Sērijas numurs).

PIEZĪME: ja netiek ievadīts pareizais sērijas numurs, tiek parādīts kļūdas paziņojums.
Pārbaudiet šajā lapā esošos piemērus un pārliecinieties, ka ir ierakstītas pareizas sūkņa
aizmugurē redzamās rakstzīmes. Ja nepieciešams, atkārtoti ievadiet šīs sešas

rakstzīmes.

8 Izmantojiet šajā lapā redzamos piemērus, lai būtu vieglāk atrast pievienojamās ierīces

sešzīmju sērijas numuru. (Ja tās atrašanai nepieciešama papildu palīdzība, noklikšķiniet uz

>>learn more (uzzināt vairāk).) Ievadiet sešas rakstzīmes laukā Device Serial Number
(Ierīces sērijas numurs).

9 Noklikšķiniet uz NEXT  (Tālāk). Tiek parādīta lapa Communication Options  (Komunikācijas

iespējas), kas ir līdzīga šādai lapai.

10 Noklikšķiniet uz nolaižamās izvēlnes Choose Port  (Izvēlēties pieslēgvietu) un atlasiet

pieslēgvietu, kuru izmantot ierīču ComLink, Paradigm Link®, CareLink USB vai Com-Station

savienošanai ar datoru. Ja nezināt, kuru pieslēgvietu izvēlēties, atlasiet Auto Detect (or USB)

(Automātiskā noteikšana (vai USB)).

CareLink Pro Lietošanas instrukcija   Darbvieta Devices (Ierīces) 29



11 Noklikšķiniet uz NEXT (Tālāk). Tiek parādīta lapa Test Connection  (Testa savienojums), kas ir

līdzīga šādai lapai.

12 Ievērojiet ar ierīci saistītos norādījumus un noklikšķiniet uz TEST (Tests).

Ja savienojums ir izveidots, tiek parādīts atbilstošs paziņojums, informējot par to. Ja tā notiek,

veiciet nākamo darbību.

PIEZĪME: šajā testā netiek nolasīti sūkņa dati, bet tiek pārbaudīta komunikācija starp

sūkni un datoru.

Ja tā nenotiek, pārbaudiet, vai aparatūra starp ierīci un datoru ir pareizi savienota.

Noklikšķiniet arī uz BACK (Atpakaļ) vedņa lapās, lai pārbaudītu, vai ievadītie ierīces dati ir

pareizi.

13 Noklikšķiniet uz DONE (Gatavs).

Ierīce ir pievienota pacienta sarakstam Active Devices (Aktīvās ierīces).

Mērītāja pievienošana

1 Noklikšķiniet uz pacienta cilnes vai veiciet dubultklikšķi uz pacienta vārda tabulā Patient

Lookup (Pacienta informācijas meklēšana).

2 Pārliecinieties, ka mērītājs, kuru jūs pievienojat, komunicē ar datoru. (Informāciju par

savienojuma izveidošanu skatiet šeit: Ierīču pievienošana lapā 24.)

3 Lai piekļūtu pacienta darbvietai Devices (Ierīces), noklikšķiniet uz pogas Devices (Ierīces).

4 Noklikšķiniet uz pogas ADD DEVICE  (Pievienot ierīces).
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5 Atlasiet Blood Glucose Meter  (Glikozes līmeņa asinīs mērītājs). Tiek parādīts vednis Add
Blood Glucose Meter  (Pievienot glikozes līmeņa asinīs mērītāju).

6 Lai izvēlētos pareizo mērītāja modeli, noklikšķiniet uz opciju pogas.

7 Noklikšķiniet uz NEXT  (Tālāk). Tiek parādīta lapa Meter Model  (Mērītāja modelis) (šī lapa

dažādiem mērītāju ražotājiem var būt atšķirīga).

8 Noklikšķiniet uz pievienojamā mērītāja modeļa.

9 Noklikšķiniet uz NEXT  (Tālāk). Tiek parādīta lapa Communication Options  (Komunikācijas

iespējas).
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PIEZĪME: pievienošanai var atlasīt tikai apstiprinātos mērītājus.

10 Noklikšķiniet uz nolaižamās izvēlnes Choose Port  (Izvēlēties pieslēgvietu) un atlasiet

pieslēgvietu, kuru varat izmantot ierīču ComLink, Paradigm Link vai CareLink USB

savienošanai ar datoru. Ja nezināt, kuru pieslēgvietu izvēlēties, atlasiet Auto Detect (or USB)
(Automātiskā noteikšana (vai USB)).

11 Noklikšķiniet uz NEXT  (Tālāk). Tiek parādīta lapa Test Connection  (Testa savienojums).

12 Ievērojiet ar mērītāju saistītos norādījumus un pēc tam noklikšķiniet uz TEST (Tests).

Pievienojot Bayer CONTOUR® USB mērītāju, pārliecinieties, ka ir aizvērta Bayer

programmatūra GLUCOFACTS®. Pārbaudiet šeit redzamo Windows sistēmas ikonjoslu. Ja ir

redzama ikona GLUCOFACTS, ar peles labo pogu noklikšķiniet uz ikonas un atlasiet Exit
(Iziet).

Ja savienojums ir izveidots, tiek parādīts atbilstošs paziņojums, informējot par to. Ja tā notiek,

veiciet nākamo darbību.

Ja tā nenotiek, pārbaudiet, vai aparatūra starp ierīci un datoru ir pareizi savienota.

Noklikšķiniet arī uz pogas BACK  (Atpakaļ) vednī, lai pārliecinātos, ka ievadītie dati ir

pareizi.

13 Noklikšķiniet uz DONE (Gatavs).

Mērītājs ir pievienots pacienta sarakstam Active Devices (Aktīvās ierīces).

Ierīces aktivēšana un deaktivēšana

Ja nepieciešams, ierīces var pārvietot no saraksta Active Devices (Aktīvās ierīces) uz sarakstu

Inactive Devices (Neaktīvās ierīces) un otrādi. Lai no ierīces nolasītu datus, tai jābūt aktīvai.

Sarakstā Active Devices (Aktīvās ierīces) var pievienot tik daudz mērītāju, cik vēlaties, taču tikai

vienu sūkni. Pirms jauna sūkņa pievienošanas pārliecinieties, ka pašreizējais sūknis ir neaktīvs.
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Ierīces deaktivēšana

1 Noklikšķiniet uz pacienta cilnes vai veiciet dubultklikšķi uz pacienta vārda tabulā Patient

Lookup (Pacienta informācijas meklēšana).

2 Lai piekļūtu pacienta darbvietai Devices (Ierīces), noklikšķiniet uz pogas Devices (Ierīces).

Sarakstā ierīcēm var būt līdzvērtīgs ierīces nosaukums. Skatiet šeit: Atbalstītās ierīces lapā 2.

3 Zem ierīces, kuru vēlaties deaktivēt, noklikšķiniet uz >> make this device inactive  (deaktivēt

šo ierīci). Ierīce tiek pārvietota uz sarakstu Inactive Devices (Neaktīvās ierīces).

Ierīces atkārtota aktivēšana

1 Noklikšķiniet uz pacienta cilnes vai veiciet dubultklikšķi uz pacienta vārda tabulā Patient

Lookup (Pacienta informācijas meklēšana).

2 Noklikšķiniet uz pogas Devices (Ierīces). Tiek parādīta pacienta darbvieta Devices (Ierīces).

Sarakstā ierīcēm var būt līdzvērtīgs ierīces nosaukums. Skatiet šeit: Atbalstītās ierīces lapā 2.

3 Zem tās ierīces, kuru vēlaties aktivēt, noklikšķiniet uz >> activate this device  (aktivēt šo

ierīci).

Ierīce tiek pārvietota uz sarakstu Active Devices  (Aktīvās ierīces).

Ierīces dzēšana

Izpildiet tālāk norādītās darbības, lai ierīci un tās datus dzēstu no darbvietas Devices (Ierīces)

un no sistēmas CareLink Pro.

1 Noklikšķiniet uz pacienta cilnes vai veiciet dubultklikšķi uz pacienta vārda tabulā Patient

Lookup (Pacienta informācijas meklēšana).

2 Lai piekļūtu pacienta darbvietai Devices  (Ierīces), noklikšķiniet uz pogas Devices  (Ierīces).

Sarakstā ierīcēm var būt līdzvērtīgs ierīces nosaukums. Skatiet šeit: Atbalstītās ierīces lapā 2.

3 Pārliecinieties, vai ierīce ir redzama sarakstā Inactive Devices (Neaktīvās ierīces). Ja nav, zem

tās pašreizējā saraksta noklikšķiniet uz >> Inactivate this device  (Deaktivēt šo ierīci).

4 Zem ierīces, kuru vēlaties dzēst, noklikšķiniet uz >> delete this device  (dzēst šo ierīci). Tiek

parādīts brīdinājuma paziņojums, informējot, ka ierīce un visi tās dati tiek dzēsti no pacienta

ieraksta.

5 Lai ierīci izdzēstu, noklikšķiniet uz YES  (Jā).

Ierīce un tās dati tiek dzēsti no darbvietas Devices (Ierīces) un no sistēmas CareLink Pro. Šīs

ierīces datus vairs nevar izmantot ziņojumiem.

Ierīces datu nolasīšana

Viens veids, kā iegūt ierīces datus, ir pieslēgties esošajam pacienta CareLink Personal kontam.

(Skatiet šeit: Saites izveidošana ar CareLink Personal kontu lapā 21.) Cits veids ir tieša datu

nolasīšana no pacienta ierīces, kā aprakstīts šajā nodaļā.
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Datus no pacienta ierīces var nolasīt, izmantojot programmatūru CareLink Pro, ja ierīce ir sarakstā

Active Devices (Aktīvās ierīces) un tā komunicē ar datoru. Kad dati ir iegūti, tos var izmantot

ziņojumu izveidošanai, kas atvieglo pacienta ārstēšanas vadības novērtēšanu. Pieejamo ziņojumu

īsu aprakstu skatiet šeit: Par ziņojumiem lapā 42.

Izmantojot programmatūru CareLink Pro, no insulīna sūkņa iespējams iegūt šādus datus:

• dažādus sūkņa iestatījumus, piemēram, trauksmes režīmu, pīkstiena skaļumu un laika

rādījumu;

• piegādāto bazālā insulīna daudzumu;

• bolus notikumus un ievadīto daudzumu;

• Bolus Wizard ierakstus;

• uzpildīto daudzumu;

• apturēšanas laikposmus;

• sensora glikozes rādījumus konkrētā laikposmā sūkņiem ar sensora īpašībām.
 
Sistēma var iegūt datus arī no sistēmas Guardian REAL-Time, tostarp:

• sensora glikozes (SG) rādījumus;

• sensora koeficienta vērtības;

• sensora kalibrēšanas koeficientus;

• ēdienreižu marķierus;

• insulīna injekcijas.
 
Turklāt ierīces rādījumu nolasīšanas laikā sistēmā var augšupielādēt dažāda veida informāciju, kas

saglabāta glikozes līmeņa asinīs mērītājā.

BRĪDINĀJUMS: lūdzu, atceliet vai pabeidziet visu īslaicīgo bazālo vai aktīvo bolus devu
ievadīšanu un dzēsiet visus aktīvos trauksmes signālus. Sūkņa darbība tiek apturēta, lai
nolasītu mērījumus. Tiklīdz mērījumu nolasīšana ir pabeigta, lūdzu, pārbaudiet, vai sūkņa

darbība ir atjaunota.

UZMANĪBU! Sūkņa datu nolasīšanas laikā nedrīkst lietot sūkņa tālvadības pulti. Ja sūkņa

akumulatora uzlādes līmenis ir zems, dati no sūkņa uz datoru netiek nosūtīti. Ja statusa
rādījums liecina, ka akumulatoram ir zems uzlādes līmenis, nomainiet bateriju.

1 Noklikšķiniet uz pacienta cilnes vai veiciet dubultklikšķi uz pacienta vārda tabulā Patient

Lookup (Pacienta informācijas meklēšana).

2 Pārliecinieties, ka ierīce komunicē ar datoru. (Skatiet šeit: Ierīču pievienošana lapā 24.)

3 Lai piekļūtu pacienta darbvietai Devices  (Ierīces), noklikšķiniet uz pogas Devices  (Ierīces).

Sarakstā ierīcēm var būt līdzvērtīgs ierīces nosaukums. Skatiet šeit: Atbalstītās ierīces lapā 2.

4 Sarakstā Active Devices (Aktīvās ierīces) atrodiet ierīci, no kuras vēlaties iegūt datus, un

pārliecinieties, ka dati laukā Choose port (Izvēlēties pieslēgvietu) ir pareizi.
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Ievadot informāciju par sūkņiem, noklikšķiniet uz nolaižamās izvēlnes Amount of Data  (Datu

apjoms) un atlasiet, cik daudz sūkņa datu vēlaties, lai programmatūra CareLink Pro

nolasītu.

5 Noklikšķiniet uz attiecīgās pogas READ DEVICE  (Nolasīt ierīci).

6 Ievērojiet ar ierīci saistītos norādījumus un noklikšķiniet uz OK (Labi).

7 Programmatūrā CareLink Pro tiek attēlota norises josla, kas tiek atjaunināta, informējot, cik

daudz ierīces rādījumu jau nolasīts.

Ierīces nolasīšanas laikā noklikšķinot uz CANCEL  (Atcelt), tiek parādīts brīdinājuma

paziņojums, informējot, ka darbības atcelšana var izraisīt jau nolasīto datu zudumu. Lai

atsāktu augšupielādi, noklikšķiniet uz pogas READ DEVICE  (Nolasīt ierīci).

- Lai atceltu, noklikšķiniet uz YES  (Jā).

- Lai turpinātu lasīt ierīces datus, noklikšķiniet uz NO (Nē).

Kad sistēma pabeidz ierīces datu nolasīšanu, tiek parādīts paziņojums, apstiprinot, ka ierīces

dati ir pilnībā nolasīti.

8 Noklikšķiniet uz OK (Labi).

- Ievērojiet norādījumus par sūkņu apturēšanas režīma pārtraukšanu.
 
Ja programmatūra CareLink Pro nespēj iegūt datus no ierīces, papildu ieteikumus skatiet nodaļā

“Traucējummeklēšana”.
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6

Darbvieta Reports (Ziņojumi)

Programmatūrā CareLink Pro tiek nodrošināti dažādi ziņojumu veidi, kas palīdz labāk kontrolēt

jūsu pacientu diabēta ārstēšanu. Katrā ziņojumā atrodamās informācijas pamatā ir dati, kas iegūti

no pacienta ierīcēm un viņa konta programmatūrā CareLink Personal.

Ziņojumus var ģenerēt ekrānā, sūtīt tieši uz drukāšanas ierīci vai saglabāt kā TIFF vai PDF failus,

kurus var pievienot elektroniskajam medicīniskajam ierakstam (Electronic Medical Record —

EMR). Ar vienu darbību var ģenerēt vairākus ziņojumu veidus.

Šajos ziņojumos attēlotie dati ir iegūti no pacienta ierīcēm, viņa CareLink Personal konta vai no

abiem avotiem.

PIEZĪME: plašāku informāciju par ziņojuma sastāvdaļām un ziņojumu paraugus varat skatīt
ziņojumu atsauces rokasgrāmatā. Ziņojumu atsauces rokasgrāmatai varat piekļūt,
programmatūrā CareLink Pro dodoties uz sadaļu Help > View Report Reference Guide (PDF)

(Palīdzība > Skatīt ziņojumu atsauces rokasgrāmatu (PDF)) un atlasot atbilstošo valodu.

Pirms darba sākšanas

Ja jums ir zināms laikposms, kuru vēlaties atspoguļot ziņojumos, ir nepieciešami arī pacienta ierīču

dati par šo laikposmu. Var būt nepieciešama arī pacienta ierīču savienošana ar datoru, lai pirms

ziņojumu veidošanas iegūtu aktuālos datus.
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Pirms ziņojuma ģenerēšanas neaizmirstiet rūpīgi izskatīt informāciju par darbību Verify Report
Settings (Pārbaudīt ziņojumu iestatīšanu). Šeit var precīzi iestatīt ziņojumu, lai atlasītu

nepieciešamos pacienta datus.

Ziņojumu izveidošana

Tālāk esošajās sadaļās sniegtā informācija palīdzēs labāk izprast, kādi ziņojumu veidi ir pieejami

un kas ir jādara, lai tos ģenerētu.

Ja zināt, kā veidot ziņojumus un kādus ziņojumus ir nepieciešams sagatavot, varat sākt ģenerēt

ziņojumus.

Darbvietas Reports (Ziņojumi) atvēršana

Noklikšķiniet uz pacienta cilnes vai pogas Open Patient  (Atvērt pacientu)  un veiciet

dubultklikšķi uz pacienta vārda.

Tiek atvērta darbvieta Reports  (Ziņojumi).

PIEZĪME: lai pārliecinātos, ka ir pieejami jaunākie ierīces dati no pacienta CareLink Personal

konta, noklikšķiniet uz SYNC DATA (Sinhronizēt datus).

Ziņojuma laikposma atlase

1 Lai mainītu laikposmu, kura atspoguļojumu vēlaties iekļaut ziņojumā(-os), noklikšķiniet uz

nolaižamās izvēlnes Duration  (Ilgums) un atlasiet posma ilgumu. (Maksimālais ilgums ir

12 nedēļas.)

2 Ja nav izvēlēta opcija custom date range  (pielāgots dienu diapazons), sākuma un beigu

datums tiek iestatīts automātiski.

PIEZĪME: ja datumu diapazons tiek izvēlēts garāks nekā atļauts, tiek parādīts kļūdas

paziņojums. Koriģējiet ilgumu vai datumus.

Ja ir nepieciešams pielāgot datumu diapazonu, noklikšķiniet uz nolaižamās izvēlnes From
(No) vai Through (Līdz) un atlasiet izvēlēto mēnesi, dienu vai gadu.

Datu kalendārs

Darbvietas Reports (Ziņojumi) datu kalendāra apgabalā tiek rādīts logs ar ziņojuma informāciju

par trīs mēnešiem.
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Zilajās joslās tiek rādīti ierīces dati. Oranžajā joslā tiek rādīts atlasītais ziņojumu laikposms. Ja

ierīces datu un ziņojumu laikposmi pārklājas, ir iegūti dati par kādu vai visiem parādītajiem

ziņojumu laikposmiem.

Sākotnēji datu kalendāra zonā tiek rādīti pēdējie trīs mēneši. Lai skatītu datus par citiem

mēnešiem, noklikšķiniet uz bultiņu pogām , pārvietojoties uz attiecīgo mēnešu sākumu vai

beigām.

Iekļaujamo sākotnējo datu atlase

1 Ja pacients lieto BG mērītāju, kas savienots ar sūkni, noklikšķiniet uz vienas no tālāk

norādītajām opcijām un izvēlieties vienu no tām, lai izveidotu mērītāja BG datu ziņojumu.

- Sūknī:  šīs atlases priekšrocība ir tā, ka ir nepieciešams nolasīt tikai pacienta sūkņa datus,

BG rādījumu datumu nosaka sūknis un rādījumi ir tieši sasaistīti ar jebkuru izmantoto

Bolus Wizard aprēķinu. Nepilnības ir atkarīgas no apgrūtinātas komunikācijas starp sūkni

un saistīto mērītāju, kuras laikā BG rādījumi par problemātisko laikposmu netiek ziņoti.

Arī MiniMed Paradigm sūkņiem, kas vecāki par modeļiem 522/722, netiek ziņoti Bolus

Wizard aprēķinu BG rādījumi, kas nav izsekoti.

- Saistītajā(-ajos) mērītājā(-ājos):  šīs atlases priekšrocību nosaka visu saistītajā mērītājā

saglabāto rādījumu iekļaušana ziņojumos. Nepilnības ir saistītas ar to, ka sūkņa un

mērītāja pulksteņiem ir jābūt savstarpēji sinhronizētiem, lai tiktu korelēti mērītāja un

sūkņa dati. Sūkņa dati un saistītā mērītāja dati ir jānolasa atsevišķi.

2 Lai ziņojumiem pievienotu ierīces datus, atlasiet izvēles rūtiņu blakus attiecīgajai ierīcei.

Nav iespējams pievienot ierīces, kas nebija iekļautas 1. darbības laikā veiktās atlases dēļ. Lai to

mainītu, atlasiet citu saistīto mērītāju.

3 Lai ziņojumos neiekļautu ierīces datus, notīriet izvēles rūtiņu blakus attiecīgajai ierīcei.

Nav iespējams notīrīt atzīmes, kas saistītas ar 1. darbības laikā atlasītajām opcijām. Lai to

mainītu, atlasiet citu saistīto mērītāju.

Ierīces datu pārbaudīšana

1 Darbvietā Reports (Ziņojumi) pārbaudiet datu kalendāru, lai pārliecinātos, vai oranžā josla,

kurā attēlots ziņojuma laikposms, pārklājas ar zilajām joslām, kurās attēloti ierīces dati.

2 Ja joslas pārklājas visā ziņojuma laikposmā, dati ziņojumam(-iem) ir pietiekami. Varat

noklikšķināt uz NEXT (Tālāk) un doties uz: Ziņojuma iestatījumu pārbaude lapā 40.

3 Ja joslas nepārklājas vai pārklājas daļēji, ir vairākas iespējas:
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- koriģēt ziņojuma laikposmu;

- iegūt ierīces papildu datus.

Papildu datu iegūšana no ierīces

1 Lai no ierīces iegūtu vairāk datu, noklikšķiniet uz attiecīgās ierīces pogas READ DEVICE

(Nolasīt ierīci).

Tiek parādīta josla Read Device (Nolasīt ierīci).

BRĪDINĀJUMS: lūdzu, atceliet vai pabeidziet visu īslaicīgo bazālo vai aktīvo bolus devu

ievadīšanu un dzēsiet visus aktīvos trauksmes signālus. Sūkņa darbība tiek apturēta, lai
nolasītu mērījumus. Tiklīdz mērījumu nolasīšana ir pabeigta, lūdzu, pārbaudiet, vai
sūkņa darbība ir atjaunota.

UZMANĪBU! Sūkņa datu nolasīšanas laikā nedrīkst lietot sūkņa tālvadības pulti. Ja

sūkņa akumulatora uzlādes līmenis ir zems, dati no sūkņa uz datoru netiek nosūtīti. Ja
ierīces statusa ekrānā ir redzams, ka akumulatoram ir zems uzlādes līmenis, nomainiet

akumulatoru.

2 Pārbaudiet, vai dati laukā Choose port (Izvēlēties pieslēgvietu) atbilst šai ierīcei.

Lai mainītu šo iestatījumu, noklikšķiniet uz šī lauka nolaižamās izvēlnes un atlasiet citu

iestatījumu.

3 Pārliecinieties, ka ierīce ir savienota ar datoru.

4 Ja šī ierīce ir sūknis, var norādīt, cik daudz datu no tās jāiegūst. Noklikšķiniet uz nolaižamās

izvēlnes Amount of Data (Datu apjoms) un atlasiet daudzumu.

PIEZĪME: ja ir atlasīta opcija All available data  (Visi pieejamie dati), sistēma sūknī
nolasīs visus datus. Tādā veidā tiek pārrakstīti sistēmā esošie dublējuma dati.

5 Noklikšķiniet uz READ DEVICE  (Nolasīt ierīci). Uzmanīgi izlasiet redzamo paziņojumu, jo tajā ir

konkrēti norādījumi par sūkņa datu nolasīšanu.

6 Izpildiet sniegtos norādījumus un noklikšķiniet uz OK (Labi).

Tiek parādīta ierīces nolasīšanas norises josla.

Nolasīšanu var atcelt jebkurā laikā, noklikšķinot uz CANCEL  (Atcelt).

Tiek parādīts paziņojums, apstiprinot, ka nolasīšana ir pabeigta.

7 Noklikšķiniet uz OK (Labi).

Tagad datu kalendārā ir redzami ierīces dati.

8 Darbvietas Reports (Ziņojumi) augšpusē noklikšķiniet uz NEXT  (Tālāk).
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Tiek parādīts darbības logs Verify Report Settings (Pārbaudīt ziņojuma iestatījumus). To

izmantojot, pirms ziņojuma(-u) izveides varat pārliecināties, vai ir pareizi iestatījumi

konkrētajam pacientam.

Ziņojuma iestatījumu pārbaude

1 Pārliecinieties, ka iestatījumiem Glucose Target (Glikozes mērķa līmenis) ir norādītas

vajadzīgās vērtības. Lai palielinātu vai samazinātu vērtības, ierakstiet šīs vērtības vai

noklikšķiniet uz augšupvērstās vai lejupvērstās bultiņas laukos Low  (Zems) un High

(Augsts).

PIEZĪME: pamošanās un gulētiešanas laika grafikā, kā arī ēdienreižu atzīmju grafikā
tiek parādītas mērītāja rādījumu atzīmes (|| |). Tā kā dažu ziņojumu pamatā ir dati, kas
iegūti noteiktos ēdienreižu, pamošanās un gulētiešanas laikos, ir svarīgi, lai pacienta

Bolus Wizard devas un mērītāja rādījumu atzīmes tiktu atbilstoši grupētas.

2 Lai pievienotu jaunu ēdienreizes laikposmu, noklikšķiniet uz ADD MEAL  (Pievienot

ēdienreizi).  Lai rediģētu esošu ēdienreizes laikposmu, noklikšķiniet jebkurā vietā uz laika ass

jebkuras ēdienreizes laikposmā.

Ēdienreižu laikposma redaktors, kas atrodas zem laika ass, tiek aktivēts.

PIEZĪME: ir iespējamas maksimāli piecas ēdienreizes. Pēc noklusējuma ir brokastis,
pusdienas un vakariņas.

3 Lai atlasītu vēlamos iestatījumus, ievadiet tekstu vai noklikšķiniet uz bultiņām.

Ja šos iestatījumus vēlaties izmantot tikai šai ēdienreizei, notīriet izvēles rūtiņu, kas atrodas

blakus laukam Use these parameters for all of this patient’s meals (Izmantot šos

parametrus visām šī pacienta ēdienreizēm).

- Meal Name (Ēdienreizes nosaukums):  ierakstiet nosaukumu, kuru vēlaties piešķirt šim

ēdienreizes laikposmam.

- Meal Time Period (Ēdienreizes laika periods): laiks stundās starp ēdienreizēm.

- Pre-Meal BG Target (mmol/L or mg/dL) (BG mērķa diapazons pirms maltītes (mmol/l
vai mg/dl)): pacienta glikozes līmeņa asinīs mērķa diapazona zemākās un augstākās

vērtības pirms ēšanas.

- Pre-Meal Analysis Period (Analīzes periods pirms maltītes): laikposms, kad glikozes

līmenis asinīs tiek analizēts pirms ēdienreizes sākuma. Šajā laikposmā iegūtie glikozes

līmeņa asinīs rādījumi tiek izmantoti detalizētai ziņojuma analīzei.

- Post-Meal BG Target (mmol/L or mg/dL) (BG mērķa diapazons pēc maltītes (mmol/l
vai mg/dl)): pacienta glikozes līmeņa asinīs mērķa diapazona zemākās un augstākās

vērtības pēc ēšanas.

- Post-Meal Analysis Period (Analīzes periods pēc maltītes): laikposms, kad glikozes

līmenis asinīs tiek analizēts pēc ēdienreizes. Šajā laikposmā iegūtie glikozes līmeņa asinīs

rādījumi tiek izmantoti detalizētai ziņojuma analīzei.

Esoša ēdienreizes laikposma ilgumu, nomoda un miega periodu var mainīt, noklikšķinot

uz sākuma vai beigu tura, velkot to pa laika asi un nometot.

CareLink Pro Lietošanas instrukcija   Darbvieta Reports (Ziņojumi) 40



PIEZĪME: ēdienreižu laikposmi nevar pārklāties, taču sākuma un beigu punkti var
robežoties viens ar otru. Ēdienreižu laikposmiem jābūt vismaz 60 minūtes ilgiem.

4 Lai izmantotu šīs ēdienreizes iestatījumus citām pacienta ēdienreizēm, pārliecinieties, ka ir

atlasīta izvēles rūtiņa blakus laukam Use these parameters for all of this patient’s meals
(Izmantot šos parametrus visām šī pacienta ēdienreizēm).

5 Kad ir pabeigta ēdienreizes laikposma izveide vai rediģēšana, noklikšķiniet uz SAVE

(Saglabāt).

6 Lai dzēstu ēdienreizes laikposmu, noklikšķiniet uz DELETE MEAL  (Dzēst ēdienreizi).  Saņemot

apstiprinājuma pieprasījumu, noklikšķiniet uz DELETE  (Dzēst).

7 Nākamajā reizē, veidojot ziņojumu šim pacientam, programmatūra CareLink Pro var

atcerēties tam veiktos iestatījumus. Lai šim pacientam saglabātu šos iestatījumus,

noklikšķiniet uz SAVE SETTINGS  (Saglabāt iestatījumus).

8 Darbvietas Reports (Ziņojumi) augšpusē noklikšķiniet uz NEXT  (Tālāk).

Šī ir norises darbība Select and Generate Reports (Ziņojumu atlase un ģenerēšana). Tajā ir

sniegts ziņojumu veidu saraksts, kā arī tabula Data (Dati), kas palīdz izvēlēties ziņojumā(-os)

Daily Detail (Ikdienas detalizēta informācija) iekļaujamās vai neiekļaujamās dienas ar

datiem.

PIEZĪME: lai mainītu tabulas Data (Dati) attēlojumu, noklikšķiniet uz >> customize
columns (pielāgot slejas). Skatiet šeit: Ziņojuma ģenerēšanas prioritātes lapā 16.

9 Lai izdrukātu ekrānā redzamos rādījumus, noklikšķiniet uz ikonas PRINT  (Drukāt) .

Ziņojuma veida un iekļaujamo datumu atlase

1 Atzīmējiet izvēles rūtiņu blakus ziņojumu kopā iekļaujamajam(-ajiem) ziņojumam(-iem).

PIEZĪME: ziņojuma Dashboard/Episode Summary (Informācijas panelis/Epizodes

kopsavilkums) izvēles rūtiņa nav pieejama, ja no sensora iegūto datu atlasītajā laika
periodā ir mazāk nekā piecas dienas vai ja laika perioda dati ir iegūti no monitora
Guardian.
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2 Ja ziņojuma laikposmā sūkņa vai monitora Guardian dati ir nolasīti vairākas reizes, var būt

vairāki ierīces momentuzņēmumi.

a. Pārliecinieties, ka ir atlasīta izvēles rūtiņa blakus laukam Device Settings Snapshot

(Ierīces iestatījumu momentuzņēmums).

b. Noklikšķiniet uz nolaižamās bultiņas un atlasiet momentuzņēmuma datumu un laiku.

- Pump (Sūknis):  atlasiet momentuzņēmumu no pacienta sūkņa.

- Guardian:  atlasiet momentuzņēmumu no pacienta monitora Guardian.

Ja kāds lauks ir blāvs, ziņojuma laikposmā momentuzņēmumi nav pieejami.

3 Lai pārskatītu ikdienas detalizētā ziņojuma informāciju, ritiniet cauri tabulai Data (Dati).

- Katras slejas datus var sašķirot. Lai datus sakārtotu augšupejošā secībā, noklikšķiniet uz

slejas nosaukuma. Lai datus sakārtotu lejupejošā secībā, vēlreiz noklikšķiniet uz slejas

nosaukuma.

PIEZĪME: ja konkrētajā datumā nav datu, šo datumu nevar atlasīt.

4 Atlasiet izvēles rūtiņu tām tabulas Data (Dati) rindām, kuru dienas datus vēlaties redzēt

ziņojumā Daily Detail (Ikdienas detalizēta informācija).

- Lai ziņojumā Daily Detail (Ikdienas detalizēta informācija) ar vienu klikšķi iekļautu visus

datumus vai izslēgtu tos no ziņojuma, atlasiet izvēles rūtiņu tabulas Data (Dati) izvēles

rūtiņu slejas augšpusē.

Ziņojumu ģenerēšana

1 Kad esat pārbaudījis ziņojumu atlasi, darbvietas Reports (Ziņojumi) augšpusē noklikšķiniet uz

lauka GENERATE REPORTS  (Ģenerēt ziņojumus).

Tiek parādīts opciju saraksts.

2 Atlasiet ziņojuma(-u) priekšskatījuma, drukāšanas vai saglabāšanas opciju.

Atlasot opciju Preview  (Priekšskats), tiek parādīts logs Preview  (Priekšskats).

3 Lai pārvietotos ziņojumus ar daudzām lapām, noklikšķiniet uz bultiņu pogām.

4 Lai saglabātu vai izdrukātu ziņojumu(-us), loga Preview  (Priekšskats) augšpusē noklikšķiniet

uz vienas no pārējām pogām.

5 Lai šo logu aizvērtu, loga augšējā labajā stūrī noklikšķiniet uz pogas Close  (Aizvērt) .

Par ziņojumiem

Šajā nodaļā sniegti visu ziņojumu apraksti. Plašāku informāciju par ziņojuma sastāvdaļām un

ziņojumu paraugus varat skatīt ziņojumu atsauces rokasgrāmatā. Ziņojumu atsauces

rokasgrāmatai varat piekļūt, izmantojot programmatūru CareLink Pro:

1 Help > View Report Reference Guide (PDF)  (Palīdzība > Skatīt ziņojumu atsauces

rokasgrāmatu (PDF)).

CareLink Pro Lietošanas instrukcija   Darbvieta Reports (Ziņojumi) 42



2 Atlasiet ziņojumu rokasgrāmatas valodu.
 
Programmatūras CareLink Pro ziņojumiem ir šādi kopēji elementi:

• Report header  (Ziņojuma galvene) — ziņojuma galvene satur identifikācijas informāciju,

piemēram, ziņojuma nosaukumu, pacienta vārdu un datu avotu;

• Carbohydrates and blood glucose levels (Ogļhidrātu un glikozes līmenis asinīs) — grafikos

un diagrammās ogļhidrātu vienības parādītas slīprakstā, bet glikozes līmeņi asinīs treknrakstā;

• Weekend data  (Nedēļas nogales dati) — nedēļas nogales dienas ir treknrakstā, tādēļ tās ir

viegli identificēt;

• Legends  (Simbolu skaidrojumi) — simbolu skaidrojumi ir redzami katra ziņojuma apakšpusē.

Lai gan simbolus var izmantot daudzos ziņojumus, skaidrojumi ir unikāli katram

ziņojumam.

Informācijas panelis/Epizodes kopsavilkums

Informācijas panelis/Epizodes kopsavilkums ir ziņojums uz divām lapām, kas ir paredzēts, lai

nodrošinātu pacienta vispārējās glikozes kontroles datus atlasītajā laika periodā. Pirmās ziņojuma

lapas nosaukums ir Therapy Management Dashboard (Ārstēšanas vadības informācijas panelis) un

otrās lapas nosaukums — Episode Summary (Epizodes kopsavilkums). Tālāk ir sniegts katras lapas

apraksts.

Ārstēšanas vadības informācijas panelis

Lapa Therapy Management Dashboard (Ārstēšanas vadības informācijas panelis) ļauj skatīt

vispārējo glikozes kontroles līmeni dienas laikā. Lapā Dashboard (Informācijas panelis) tiek

uzskicēts ikdienas grafiks, atspoguļojot no sensora iegūtos glikozes pārklājuma rādītājus un

insulīna ievades informāciju. Lapā Dashboard (Informācijas panelis) ir redzams arī nakts laika

periods un ar ēdienreizēm saistītie laika periodi, atvieglojot glikozes kontroles novērtēšanu pirms

un pēc ēdienreizēm. Izmantojot šos grafikus, var vizuāli novērtēt klīniskos modeļus, piemēram,

hiperglikēmiju, hipoglikēmiju un rādītājus vispārējās glikozes kontroles grafiskā skatījuma

ietvaros. Lapā Dashboard (Informācijas panelis) ir iekļauti konkrētā dienas daļā atkārtoti novērotās

hipoglikēmijas un hiperglikēmijas statistiskās analīzes paraugi.

Turklāt lapa Dashboard (Informācijas panelis) ļauj savstarpēji saistīt glikēmijas kontroli noteiktā

dienas daļā ar galvenajiem terapijas modifikatoriem, piemēram, bazālās devas režīma, insulīna

absorbcijas, insulīna jutības un ogļhidrātu attiecību. Tādējādi tiek ierobežota nepieciešamība

manuāli saistīt gadījumus, izmantojot vairākus ziņojumus. Lapā Dashboard (Informācijas panelis)

ir redzami arī vispārīgie sūkņa un sensora izmantošanas statistiskie dati.

Epizodes kopsavilkums

Lapā Episode Summary (Epizodes kopsavilkums) ir sniegta detalizēta informācija par

hipoglikēmijas un hiperglikēmijas epizodēm. Izmantošanai turpmākajos izmeklējumos, tajā tiek

izceltas kritiskākās epizodes un interesējošo, savstarpēji saistīto gadījumu biežums. Ziņojumā ir

minēti biežāk zināmie hipoglikēmijas un hiperglikēmijas (ja tāda ir) noviržu cēloņi, kā arī sniegti

ieteikumi ārstēšanai.
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Lapā Episode Summary (Epizodes kopsavilkums) ir sniegti arī vispārīgi novērojumi par

galvenajiem uzvedības un atbilstības mērījumiem, kas ir saistīti ar insulīna sūkņa, CGM un BG

mērītāja lietošanu. Šie novērojumi var nebūt saistīti ar epizodēm.

Ziņojums par režīma ievērošanu

Ziņojumā Adherence (Režīma ievērošana) tiek atspoguļoti dati, kas attiecas uz insulīna sūkņu un

sensoru lietošanu, kā arī pacienta uzvedība saistībā ar nozīmēto terapiju. Tajā ir sniegta atbilde uz

jautājumu — vai datu apjoms ir pietiekams, lai nodrošinātu precīzu pacienta insulīna sūkņa un

sensora, ja tādi ir, lietošanas režīma raksturojumu. Tajā ir sniegta arī atbilde uz jautājumu — vai

pacients ievēro noteiktos ārstēšanas noteikumus. Tas arī norāda, vai jums vajadzētu pārrunāt ar

saviem pacientiem, kā viņi kontrolē savu diabētu.

Sensora un mērītāja pārskata ziņojums

Sensora un mērītāja pārskata ziņojumā ir nodrošināts pacienta mērītāja katru dienu noteiktā

glikozes līmeņa asinīs un vidējo rādītāju grafisks attēlojums, iekļaujot stundu iedalījumu

24 stundu garumā un šo datu korelāciju ar ēdienreizēm un miega režīmu. Ir iekļauti arī statistikas

dati par pacienta glikozes līmeņa asinīs rādījumiem un insulīna patēriņu.

Ja tiek lietots sensors, līdzīga sensora datu analīze tiek ģenerēta kā šī ziņojuma pirmā lapa. Ja

sensora dati nav pieejami, kā pirmā lapa tiek ģenerēta mērītāja datu analīze.

Ziņojuma noslēguma lapā(-ās) ir redzams, kā pacients kontrolē glikozes, ogļhidrātu un insulīna

patēriņu pa dienām. Katrā lapā ir redzams, kā kontrole mainās dienas laikā visā ziņojuma

laikposmā, vienā lapā iekļaujot maksimāli 14 dienu rādījumus.

Ierakstu žurnāla ziņojums

Ziņojums Logbook (Ierakstu žurnāls) nodrošina glikozes mērītāja, ogļhidrātu un insulīna datus par

katru ziņojuma laikposma dienu. Tajā ir dienasgrāmata, atspoguļojot katras stundas notikumus, kā

arī dienas vidējos un kopējos rādītājus. Katrā lapā ir maksimāli 14 dienu ieraksti. Ja ziņojuma

laikposms ir ilgāks par 14 dienām, tiek ģenerētas papildu lapas.

Ierīces iestatījumu momentuzņēmums

Ziņojumā Device Settings Snapshot (Ierīces iestatījumu momentuzņēmums) ir attēloti pacienta

sūkņa vai monitora Guardian REAL-Time iestatījumu momentuzņēmumi konkrētā datumā un

laikā. Tie var palīdzēt saprast citus ziņojumus vai tikai reģistrēt pacienta iestatījumus.

Sūkņa un monitora iestatījumi tiek reģistrēti tikai tad, kad ierīce tiek nolasīta. Ja ierīce nav nolasīta

ziņojuma laikposmā, neviens iestatījums nav pieejams.

Ikdienas detalizētas informācijas ziņojums

Ziņojumā Daily Detail (Ikdienas detalizēta informācija) tiek parādīti glikozes dati, ogļhidrātu

daudzums un pacienta insulīna patēriņš atlasītajā dienā. Katrai tabulā Data (Dati) izvēlētajai dienai

tiek ģenerēts atsevišķs ziņojums.
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Ziņojumā Daily Detail (Ikdienas detalizēta informācija) ir sniegts detalizēts pārskats par katru

atlasīto dienu. Tas ļauj koncentrēties uz konkrētu dienu, ja jums šķiet, ka pacienta ārstēšanā ir

noticis kaut kas, kam jāpievērš uzmanība.

Datu eksportēšana

Iegūtos ierīces datus var eksportēt un saglabāt, izmantojot programmatūru CareLink Pro.

Programmatūra ļauj izmantot visus pacienta ierīces datus statistisko datu iegūšanai vai specifisku

ziņojumu un diagrammu izveidošanai. Iespējams importēt .csv failu programmā Microsoft Excel

vai atsevišķās klīniskās statistikas programmās, kur to var papildus apstrādāt.

Šie .csv faili satur datus, kuros ir ierakstītas ierīces darbības. Piemēram, tajos ir mērītāja rādījumu

ieraksti, sūkņa ieraksti, kas saņem mērītāja rādījumu vērtības, pamata ātruma izmaiņas.

PIEZĪME: tā ir papildu funkcija, tādēļ ir nepieciešams pārzināt ierīces jēldatus. Šim nolūkam

nepieciešama arī to programmu pārzināšana, kurā tiek importēts .csv fails.

Lai izmantotu programmatūras CareLink Pro eksportēšanas funkciju, veiciet tālāk norādītās

darbības.

1 Noklikšķiniet uz pacienta cilnes vai pogas Open Patient  (Atvērt pacientu)  un veiciet

dubultklikšķi uz pacienta vārda.

2 Pārliecinieties, ka tiek parādīta darbvieta Reports  (Ziņojumi).

3 Lai iestatītu datumu un ziņojuma laikposma ilgumu, izmantojiet laukus Duration  (Ilgums) vai

From/Through (No/Līdz).

Maksimālais atlasei pieejamais ilgums ir 12 nedēļas.

4 Noklikšķiniet uz saites export selected data (eksportēt atlasītos datus).

Tiek parādīts dialoglodziņš Export Data to CSV File  (Eksportēt datus uz CSV failu).

5 Dodieties uz vietu, kur savā datorā vēlaties saglabāt .csv failu. Ja vēlaties mainīt faila

nosaukumu, ierakstiet to lodziņā File name  (Faila nosaukums).

6 Noklikšķiniet uz SAVE (Saglabāt).

PIEZĪME: lai iegūtu papildu informāciju par datiem, kas tiek parādīti CSV failos, skatiet
CSV datu pielikumu.

Tagad .csv fails ir saglabāts jūsu datorā izvēlētajā vietā. To var importēt arī citās programmās,

kas atbalsta šo faila veidu.
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Sistēmas administrēšana

Ir svarīgi regulāri veidot CareLink Pro datubāzes dublējumu. Datubāzē tiek glabāti visi sistēmas

dati, kas ir apkopoti pacienta ierakstos, tostarp profila informācija, ierīču dati un ziņojuma

iestatījumi.

Svarīga ir arī pieeja jaunākajai programmatūras CareLink Pro versijai. Periodiski ir pieejamas

atjauninātās programmatūras versijas, kurās var būt veikti nozīmīgi uzlabojumi. Lietotājs var

izvēlēties atjauninājumus meklēt pats vai saņemt paziņojumu, kad tie būs pieejami.

Programmatūras atjauninājumu lietošana

Programmatūrai CareLink Pro ir pieejami neregulāri atjauninājumi. Kad tiek parādīts

paziņojums par atjauninājumu, veiciet tālāk norādītās darbības, lai lejupielādētu jaunāko

programmatūras versiju.

PIEZĪME: pirms programmatūras atjauninājumu lietošanas ir jāveic datubāzes dublēšana.
Skatiet šeit: Datubāzes dublēšana lapā 47.

1 Pārliecinieties, vai jūsu datoram ir savienojums ar internetu un tas ir aktīvs.

2 Kad ir pieejams programmatūras CareLink Pro atjauninājums, tiek parādīts paziņojums

CareLink Pro Update (CareLink Pro atjauninājums). Tiek piedāvāta iespēja lejupielādēt

atjauninājumu.

3 Noklikšķiniet uz DOWNLOAD  (Lejupielādēt). (Noklikšķinot uz CANCEL (Atcelt), atjauninājuma

paziņojums tiek aizvērts. Atjauninājumu var lejupielādēt vēlāk).

Tiek parādīts brīdinājuma paziņojums, kas iesaka veikt datubāzes dublējumu.

4 Lai izveidotu datubāzes dublējumu, noklikšķiniet uz YES  (Jā) (informāciju par šo procedūru

skatiet šeit: Datubāzes dublēšana lapā 47). Ja datubāzes dublējums jau ir izveidots,

noklikšķiniet uz NO (Nē).

Tiek parādīts paziņojums, apstiprinot, ka jaunā programmatūras CareLink Pro versija ir

lejupielādēta.

CareLink Pro Lietošanas instrukcija   Sistēmas administrēšana 46



5 Lai sāktu lietot jaunāko programmatūras CareLink Pro versiju, noklikšķiniet uz YES  (Jā), lai

aizvērtu un atkal atvērtu lietojumprogrammu. Ja nevēlaties veikt programmatūras CareLink

Pro restartēšanu, noklikšķiniet uz NO (Nē).

Automātiskās atjaunināšanas atslēgšana

Ja nevēlaties saņemt automātiskos paziņojumus par programmatūras CareLink Pro

atjauninājumiem, veiciet tālāk norādītās darbības.

1 Atlasiet Tools > Options  (Rīki > Iespējas).

2 Noklikšķiniet uz cilnes General (Vispārīgi).

3 Sadaļā Communications (Sakari) notīriet izvēles rūtiņu blakus laukam Automatically check

for software updates  (Automātiski pārbaudīt programmatūras atjauninājumus).

Manuāla atjauninājumu pārbaude

Manuālo programmatūras CareLink Pro atjauninājumu pārbaudi var veikt jebkurā laikā.

PIEZĪME: pirms programmatūras atjauninājumu lietošanas ir jāveic datubāzes dublēšana.
Skatiet šeit: Datubāzes dublēšana lapā 47.

1 Pārliecinieties, vai jūsu datoram ir savienojums ar internetu un tas ir aktīvs.

2 Atlasiet Tools > Check for Software Updates (Rīki > Pārbaudīt programmatūras

atjauninājumus).

3 Ja atjauninājumi pašreiz nav pieejami, tiek nosūtīts paziņojums. Ja atjauninājums ir pieejams,

tiek parādīts paziņojums CareLink Pro Update (CareLink Pro atjauninājums).

4 Ievērojiet procedūru, kas aprakstīta šeit: Programmatūras atjauninājumu lietošana lapā 46.

Datubāzes dublēšana un atjaunošana

Ir lietderīgi izveidot grafiku, saskaņā ar kuru tiek veidoti regulāri datubāzes dublējumi. Tas

palīdzēs nodrošināt regulāru datu bāzes dublēšanu un samazināt datu zuduma risku.

Ja datubāzes dublēšanas vai atjaunošanas laikā pie citiem datoriem ir aktīvi programmas lietotāji,

sistēmā tiek parādīts brīdinājuma ziņojums.

Datubāzes dublēšana

Lai dublētu pašreizējo datubāzi izvēlētajā vietā, veiciet tālāk norādītās darbības.

1 Pārliecinieties, vai visi pacientu ieraksti ir aizvērti.

2 Atlasiet Tools > Backup Database  (Rīki > Dublēt datubāzi).

PIEZĪME: datubāzes dublējumus var saglabāt tīkla diskā vai noņemamā atmiņas
krātuvē (piemēram, DVD, CD vai USB diskdzinī).

3 Dodieties uz vietu savā datorā, kur vēlaties saglabāt dublējuma failu. Ja vēlaties mainīt

dublējuma faila nosaukumu, ierakstiet to lodziņā File name  (Faila nosaukums).
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4 Noklikšķiniet uz Save (Saglabāt). Datubāzes saglabāšanas darbības laikā tiek parādīta procesa

norises josla.

Kad dublējums ir pabeigts, tiek parādīts paziņojums.

5 Lai aizvērtu paziņojumu, noklikšķiniet uz OK (Labi).

Datubāzes atjaunošana

Ja pašreizējai datubāzei vairs nevar piekļūt vai nav iespējams to izmantot, var būt

nepieciešams to aizvietot. Jo jaunāks ir dublējums, jo mazāk datu tiek zaudēts, aizvietojot

datubāzi.

UZMANĪBU! Veicot datubāzes atjaunošanu no dublējumkopijas, tiek zaudēti visi jaunākie
dati, kas pašreizējā datubāzē izveidoti pēc atlasītās dublējumkopijas izveidošanas.

Lai aizvietotu esošo datubāzi ar dublējumkopiju, veiciet tālāk norādītās darbības.

1 Pārliecinieties, vai visi pacientu ieraksti ir aizvērti.

2 Atlasiet Tools > Restore Database  (Rīki > Atjaunot datubāzi).

3 Atlasiet dublējuma failu, kuru vēlaties izmantot pašreizējās datubāzes aizvietošanai (parasti

visjaunāko).

4 Noklikšķiniet uz Open (Atvērt). Tiek parādīts brīdinājuma ziņojums, atgādinot par iespējamo

datu zudumu, ja datubāzes atjaunošana tiek turpināta.

5 Lai turpinātu, noklikšķiniet uz OK  (Labi). Datubāzes atjaunošanas darbības laikā tiek parādīta

procesa norises josla.

Kad datubāze ir atjaunota, tiek parādīts paziņojums.

6 Lai aizvērtu paziņojumu, noklikšķiniet uz OK (Labi).

Ja sistēma nav pieejama

Ja sistēmu mēģināsiet ieslēgt, kamēr cits lietotājs veic dublēšanu vai atjaunošanu, tiks parādīts

paziņojums, informējot, ka sistēma nav pieejama. Kamēr šis uzdevums nebūs pabeigts, sistēmai

nevarēsiet piekļūt.

Veiciet vienu no šīm darbībām:

• nogaidiet, līdz process tiek pabeigts un sistēma ir pieejama;

• lai izietu un vēlāk mēģinātu vēlreiz, noklikšķiniet uz CANCEL (Atcelt).
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Traucējummeklēšana

Šajā nodaļā sniegtā informācija palīdzēs atrisināt problēmas, kas radušās, lietojot programmatūru

CareLink Pro. Tajā ir atrodami arī norādījumi, kā, ja nepieciešams, veikt programmatūras CareLink

Pro atinstalēšanu.

Vispārējas lietojumprogrammas kļūdas

Mēģinot lejupielādēt programmatūras atjauninājumus internetā, var tikt parādīts paziņojums,

ka lietotājam nav atbilstošo privilēģiju to darīt. Lai lejupielādētu programmatūras CareLink Pro

atjauninājumus, ir jābūt administratora privilēģijām.

1 Aizveriet programmatūras CareLink Pro lietojumprogrammu un restartējiet datoru.

2 Lūdziet, lai kāds ar administratora privilēģijām piesakās datorā.

3 Izpildiet norādījumus, kas sniegti šeit: Programmatūras atjauninājumu lietošana lapā 46.

Nav savienojuma ar datubāzi

Kļūdas paziņojums, kas informē, ka nav savienojuma ar datubāzi, nozīmē vienu no tālāk

minētajām iespējām.

• Datubāze ir pārvietota. Datubāzei jāatrodas turpat, kur tā atradās programmatūras CareLink

Pro instalēšanas brīdī. Ja tā ir pārvietota, tā jāpārvieto atpakaļ uz to vietu, kur tā bija

instalēšanas brīdī.

• Nav savienojuma ar tīkla disku, kurā atrodas datubāze. Ja datubāze atrodas tīkla diskā, tīklam

reizēm var būt problēmas, kas neļauj piekļūt diskam. Sazinieties ar datoratbalsta nodaļu, kas

palīdzēs atkārtoti izveidot savienojumu ar tīkla disku, kurā atrodas datubāze.
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Aizmirsta klīnikas parole darbam ar programmatūru CareLink Pro

Ja ir aizmirsta parole, ko klīnika izmanto, lai pieteiktos programmatūrā CareLink Pro, šī

programmatūra ir atkārtoti jāinstalē un ir jāizveido jauna datubāze. Pēc programmatūras

atkārtotas instalēšanas iepriekšējā datubāzē saglabātajai pacienta informācijai nav iespējams

piekļūt. Lai nezaudētu turpmākos datus, veicot jauno instalēšanu, saglabājiet izveidoto paroli

birojā.

Ierīces nolasījumu kļūdas

Kļūda Izskaidrojums

The selected serial port could not be opened. Another
operation might be in progress on that port. Please
wait until the port is available, or select another port.
(Izvēlēto seriālo pieslēgvietu nav iespējams atvērt. Šajā
pieslēgvietā var noritēt cita darbība. Lūdzu, uzgaidiet,
kamēr pieslēgvieta tiek atbrīvota, vai meklējiet citu
pieslēgvietu.)

Lūdzu, pārbaudiet, vai izvēlēto COM pieslēgvietu
neizmanto cita programma, vai izvēlieties citu
pieslēgvietu. Mēģiniet atsāknēt izmantoto datoru, pēc
tam mēģiniet vēlreiz veikt ierīces nolasīšanu.
Pieslēgvietai pievienotā aparatūra (piemēram, kabelis)
var būt bojāta, vai pati pieslēgvieta var būt bojāta.
Pievienojiet aparatūru citai pieslēgvietai un mēģiniet
vēlreiz nolasīt ierīci, lai noteiktu problēmu.

Auto Detect could not find the device on any
available port. Please check the cable connection,
device battery & status and try again, or try specifying
a serial port. (Automātiskās noteikšanas funkcija
neatrod ierīci nevienā pieslēgvietā. Lūdzu, pārbaudiet
kabeļa savienojumu, ierīces akumulatoru un tā statusu,
pēc tam mēģiniet vēlreiz vai norādiet seriālo
pieslēgvietu.)

Pārbaudiet kabeļa un datora savienojumu, kā arī
pārbaudiet, vai akumulatora uzlādes līmenis ir
atbilstošs. Ja tā ir, mēģiniet opcijas Auto Detect
(Automātiskā noteikšana) atlases vietā norādīt datora
seriālo pieslēgvietu, kam pievienot kabeli.

Device not found at selected serial port. Please check
the cable connection, device battery & status and try
again, try selecting a different port, or try to Auto
Detect the device. (Atlasītajā seriālajā pieslēgvietā
ierīce nav atrodama. Lūdzu, pārbaudiet kabeļa
savienojumu, ierīces akumulatoru un tā statusu un
mēģiniet vēlreiz; atlasiet citu pieslēgvietu vai mēģiniet
noteikt ierīci, izmantojot automātiskās noteikšanas
funkciju.)

Pārbaudiet kabeļa un datora savienojumu, kā arī
pārbaudiet, vai akumulatora uzlādes līmenis ir
atbilstošs. Ja tā ir, mēģiniet izvēlēties citu datora
seriālās pieslēgvietas numuru vai izvēlieties opciju
Auto Detect (Automātiskā noteikšana).

Unable to communicate with the device. Please ensure
you’ve attached and selected the correct device, check
the cable connection, device battery and status, and
try again. (Nav iespējams sazināties ar ierīci. Lūdzu,
pārliecinieties, ka ir pievienota un izvēlēta pareizā
ierīce, pārbaudiet kabeļa savienojumu, ierīces
akumulatoru un tā statusu un mēģiniet vēlreiz.)

Pārbaudiet visus ierīces nolasīšanas iestatījumus,
tostarp ierīces nosaukumu, seriālo numuru un
savienojuma veidu. Pārbaudiet arī to, vai ierīce, kabelis
un dators ir pareizi savienoti. Pārbaudiet, vai ierīces
akumulatora un trauksmes signāla statuss ir atbilstošs.
Mēģiniet nolasīt vēlreiz.

Unexpected response... retrying (n%). (Neparedzēta
atbilde... atkārtots mēģinājums (n%).)

No ierīces nolasīta neparedzēta vērtība. Sistēma
mēģina sazināties atkārtoti, līdz komunikācija tiek
atcelta vai ir veiksmīga.

The link device was found, but the device (<serial #>)
is not responding. Please verify the pump’s serial
number, place the pump closer to the communication
device to minimize interference, check pump battery
and status. (Saiti veidojošā ierīce ir noteikta, bet sūknis
(<sērijas nr.>) nereaģē. Lūdzu, pārbaudiet sūkņa sērijas
numuru, novietojiet sūkni tuvāk komunikācijas ierīcei,
lai mazinātu signāla traucējumus, pārbaudiet sūkņa
akumulatoru un tā statusu.)

Pārbaudiet, vai ievadīts pareizais sērijas numurs. Ja
numurs nav pareizs, atkārtoti ievadiet pareizo seriālo
numuru. Ja sērijas numurs ir pareizs, pārvietojiet saiti
veidojošo ierīci tuvāk komunikācijas ierīcei.  Pārvietojiet
saiti veidojošo ierīci un komunikācijas ierīci tālāk no
iespējamiem traucējumu avotiem (piemēram, citām RF
ierīcēm). Pārbaudiet ierīces akumulatora jaudu un, ja
tiek lejupielādēts insulīna sūknis, arī sūkņa piegādes
statusu.

CareLink Pro Lietošanas instrukcija   Traucējummeklēšana 50



Kļūda Izskaidrojums

This pump is delivering a temp basal. Please cancel
the temp basal or wait until it completes, and then try
again. (Šis sūknis ievada īslaicīgo bazālo devu. Lūdzu,
atceliet īslaicīgās bazālās devas ievadi vai nogaidiet,
līdz tās ievade tiek pabeigta, pēc tam mēģiniet
vēlreiz.)

Sūknis, kuru mēģināt nolasīt, šobrīd nodrošina
īslaicīgās bazālās devas ievadīšanu. Lai nolasītu sūkni,
nogaidiet, līdz tiek pabeigta īslaicīgās bazālās devas
ievadīšana, vai atceliet īslaicīgās bazālās devas
ievadīšanu un pēc tam nolasiet sūkni.

This device has active errors or alarms. Please clear
the alarms and try again. (Šai ierīcei ir aktīvas kļūdas
vai trauksmes signāli. Lūdzu, dzēsiet trauksmes
signālus un mēģiniet vēlreiz.)

Sūknim ir aktīvi trauksmes signāli, kas var traucēt tā
nolasīšanu. Lai trauksmes signālu dzēstu, izlasiet
attiecīgos norādījumus trauksmes signālu. Dzēsiet
trauksmes signālu un mēģiniet sūkni nolasīt vēlreiz.

This pump is delivering a bolus. Please cancel the
bolus or wait until it completes, and then try again.
(Šis sūknis ievada bolus devu. Lūdzu, atceliet bolus
devas ievadīšanu vai nogaidiet, līdz tiek pabeigta tās
ievadīšana, pēc tam mēģiniet vēlreiz.)

Sūknis, kuru vēlaties nolasīt, pašlaik nodrošina bolus
devas ievadīšanu. Lai nolasītu sūkni, nogaidiet, līdz tiek
pabeigta bolus devas ievadīšana, vai atceliet bolus
devas ievadīšanu un pēc tam nolasiet sūkni.

The device returned invalid entries; all data read will
be discarded. (Ierīce atgriež nederīgus ierakstus; visi
datu nolasījumi tiks atmesti.)

Sazinieties ar vietējo pārstāvi (skatiet šeit: Palīdzība
lapā 2).

Ziņojuma izveidošanas kļūdas

Vairāki datu ieraksti ar vienādu datumu

Ja vienai ierīcei vienā datumā un laikā ir vairāki ieraksti, sistēma uzskata, ka tā ir pretruna, kuru nav

iespējams atrisināt. Ziņojumos, kas izveidoti, izmantojot šīs ierīces datus, tiek izlaista tā daļa datu,

kas pārklājas.

Lai izlaistu pārklājušos datus, varat koriģēt ziņojuma laikposmu vai arī dzēst ierīci no sistēmas un

pēc tam to atkal pievienot, lai dzēstu iepriekšējos rādījumus.

Sistēma ignorē datus

Ja ierīces laiks ir mainīts tā, ka tas rada datu pārklājumus vai iztrūkumus trīs stundas vai ilgāk,

sistēma, veidojot ziņojumus, šo datu daļu neiekļauj.

Dublējuma un atjaunošanas kļūdas

Datubāzi nevar bloķēt

Tas nozīmē, ka datubāze tiek izmantota vairāku lietotāju vidē, kurā ir pieteikušies citi lietotāji.

Sistēma nepieļauj datubāzes dublēšanu, kamēr citi lietotāji,  iespējams, veic uzdevumus, kas var

ietekmēt datubāzi. Kad citi lietotāji ir izgājuši no programmatūras CareLink Pro, varat izveidot

datubāzes dublējumu.

Datubāzes dublējums vai atjaunošana nav pabeigta

Nevar pieteikties citi lietotāji,  un nav iespējams pabeigt datubāzes dublēšanu vai atjaunošanu.

Lūdzu, sazinieties ar vietējo pārstāvi (skatiet šeit: Palīdzība lapā 2).

Datubāzes atjaunošana neizdodas

Datubāzes dublējuma fails, no kura mēģināt atjaunot bāzi, ir bojāts. Mēģiniet veikt atjaunošanu,

izmantojot citu dublējuma failu.
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Programmatūras atinstalēšana

Ja ir nepieciešams atinstalēt programmatūru CareLink Pro, veiciet tālāk norādītās darbības.

1 Windows izvēlnē Start  (Sākt) atveriet opciju Control Panel (Vadības panelis).

2 Atlasiet Add or Remove Programs  (Pievienot vai noņemt programmas). Tiek parādīts

sistēmas Windows logs Add or Remove Programs (Pievienot vai noņemt programmas).

3 Ritiniet uz leju līdz programmai Medtronic CareLink Pro  un noklikšķiniet uz tās.

4 Noklikšķiniet uz Remove (Noņemt). Tiek parādīts logs Install Shield Wizard (Instalēšanas

ekrāna vednis).

5 Noklikšķiniet uz NEXT  (Tālāk). Tiek parādīts paziņojums, lūdzot apstiprināt, vai vēlaties

noņemt lietojumprogrammu.

6 Noklikšķiniet uz Yes (Jā). Tiek palaists programmas atinstalēšanas process, un no datora tiek

noņemta programma ar visiem tās failiem. Kad tas ir izdarīts, vedņa ekrānā tiek parādīts

paziņojums, apstiprinot atinstalēšanu.

7 Noklikšķiniet uz Finish (Pabeigt).
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Ikonu tabula

Tālāk esošajā tabulā ir izskaidrotas ikonas un simboli, kas ir redzami iepakojuma marķējumā un uz

aparatūras.

Apraksts Ikona

Viena vienība konteinerā/iepakojumā (1X)

CD iekļauts

Skatīt lietošanas instrukcijas

Ražošanas datums (gads)

Kataloga numurs

Conformité Européene (Eiropas atbilstība). Šis simbols
norāda, ka ierīce pilnībā atbilst Direktīvai 93/42/EEK
par medicīnas ierīcēm.
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CSV dati

Veicot datu eksportēšanu no programmatūras CareLink Pro, dati tiek eksportēti .csv failā. Šo failu

iespējams importēt izklājlapu lietojumprogrammā, piemēram, Microsoft Excel. Visu CSV failā

ietveramo datu uzskaitījumu skatiet CSV faila sleju definīcijās.

CSV failā ir ietverta informācija ar pacienta vārdu un pacienta ID, ziņojuma laikposmu un

identificēta katra ziņojumā iekļautā ierīce.

Slejas datu definīcijas

Slejas nosaukums Definīcija

Index (Rādītājs) Secība, kādā dati tiek ierakstīti ierīcē.

Date (Datums) Datums, kad dati tiek ierakstīti ierīcē.

Time (Laiks) Laiks, kad dati tiek ierakstīti ierīcē.

New Device Time (Jauns ierīces laiks) Jauns datums un laiks, ja tas ierīcē ticis mainīts.

BG Reading (mmol/L or mg/dL) (BG rādījums (mmol/l
vai mg/dl))

Glikozes līmeņa asinīs rādījums, ko ierakstījis mērītājs,
Guardian vai sūknis. Ja dati ir iegūti no sūkņa vai
monitora Guardian, šajā slejā tiek atspoguļoti manuāli
ievadīti BG rādījumi vai BG rādījumi, kas saņemti no
saistītā mērītāja.

Linked BG Meter ID (Saistīta BG mērītāja ID) Mērītāja, kurš sūta konkrētu glikozes līmeņa asinīs
rādījumu uz ierīci, sērijas numurs.

Basal Rate (U/h) (Bazālās devas ātrums (U/st.)) Aktīvais bazālās insulīna devas ievades ātrums
vienībās/stundā.

Temp Basal Amount (Īslaicīgās bazālās devas ievades
daudzums)

Ja sūknī tiek izmantota īslaicīgā bazālā deva, šī vērtība
ir īslaicīgās bazālās devas apjoms.

Temp Basal Type (Īslaicīgās bazālās ievades veids) Īslaicīgā bazālās ievades veida korekcija (insulīna
ātrums vai procenti no bazālās devas ievades ātruma).

Temp Basal Duration (m) (Īslaicīgās bazālās devas
ievades ilgums (min.))

Īslaicīgās bazālās insulīna devas ievades laiks minūtēs
(veidu skatiet iepriekš).

Bolus Type (Bolus devas veids)
Bolus insulīna devas ievades veids [parastais,
pagarinātais, dubultais (parastā daļa) vai dubultais
(pagarinātā daļa) vilnis].

Bolus Volume Selected (U) (Izvēlētais bolus devas
tilpums (U))

Izvēlētais insulīna vienību skaits, kas jāievada insulīna
bolus devas veidā.
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Slejas nosaukums Definīcija

Bolus Volume Delivered (U) (Padotais bolus devas
tilpums (U))

Faktiski padotais insulīna vienību skaits, kas faktiski
ievadīts insulīna bolus devas veidā.

Programmed Bolus Duration (h) (Ieprogrammētais
bolus ievadīšanas ilgums (st.))

Pagarinātā viļņa bolus devas vai dubultā viļņa
pagarinātās daļas ievades ilgums.

Prime Type (Uzpildes veids)

Manuāls vai fiksēts. Manuālā uzpilde tiek lietota uzreiz
pēc ierīces uzvilkšanas, lai piepildītu insulīna infūzijas
komplekta caurulītes ar insulīnu pirms tā ievadīšanas.
Fiksēto ievadīšanas veidu izmanto pēc tam, kad ir
ievietots infūzijas komplekts, lai pēc ievadīšanas adatas
izņemšanas piepildītu mīksto kanulu ar insulīnu.

Prime Volume Delivered (U) (Ievadītais uzpildītās devas
tilpums (U))

Insulīna vienību skaits, kas faktiski tika izmantots
uzpildīšanai.

Alarm (Trauksme) Trauksmes signāla nosaukums.

Suspend (Apturēt) Identificē apturētā sūkņa statusu.

Rewind (Pārtīt) Ierīces pārtīšanas datums un laiks.

BWZ Estimate (U) (BWZ aprēķins (U)) Bolus insulīna devas aprēķins, ko veic ar Paradigm
sūkņa funkciju Bolus Wizard (Bolus devas vednis).

BWZ Target High BG (mmol/L or mg/dL) (BWZ mērķa
augsts BG (mmol/l vai mg/dl))

Glikozes līmeņa asinīs mērķa diapazona augšējās
robežas iestatījums, ko izmanto funkcija Bolus Wizard
(Bolus devas vednis).

BWZ Target Low BG (mmol/L or mg/dL) (BWZ mērķa
zems BG (mmol/l vai mg/dl))

Glikozes līmeņa asinīs mērķa diapazona apakšējās
robežas iestatījums, ko izmanto funkcija Bolus Wizard
(Bolus devas vednis).

BWZ Carb Ratio (BWZ ogļhidrātu daļa)

Insulīna un ogļhidrātu attiecības iestatījums. Ja kā
vienības tiek izmantoti grami, attiecība ir gramu skaits,
ko noārda viena insulīna vienība. Ja kā vienības tiek
izmantota apmaiņas, attiecība ir insulīna vienību skaits,
ko izlieto vienai apmaiņai.

BWZ Insulin Sensitivity (BWZ insulīna jutība)

Insulīna jutības iestatījums. Insulīna jutība ir asins
glikozes līmeņa lielums, ko samazina viena insulīna
vienība. To izmanto funkcija Bolus Wizard (Bolus devas
vednis).

BWZ Carb Input (BWZ ogļhidrātu ievade)
Ogļhidrātu daudzums, kas ievadīts vednī Bolus Wizard
(Bolus devas vednis) un ko lieto bolus devas
aprēķināšanai.

BWZ BG Input (mmol/L or mg/dL) (BWZ BG ievade
(mmol/l vai mg/dl))

Glikozes līmeņa asinīs rādījums, kas ievadīts vednī
Bolus Wizard (Bolus devas vednis) un ko lieto bolus
devas aprēķināšanai.

BWZ Correction Estimate (U) (BWZ korekcijas aprēķins
(U))

Bolus insulīna vienības glikozes līmeņa asinīs korekciju
veikšanai, kas aprēķinātas, izmantojot funkciju Bolus
Wizard (Bolus devas vednis).

BWZ Food Estimate (U) (BWZ pārtikas aprēķins (U))

Aprēķinātās bolus insulīna vienības paredzētā
ogļhidrātu patēriņa daudzuma nosegšanai, kas
aprēķinātas, izmantojot funkciju Bolus Wizard (Bolus
devas vednis).

BWZ Active Insulin (U) (BWZ aktīvais insulīns (U))

Aprēķinātais aktīvā insulīna daudzums, kas palicis
organismā no iepriekšējām bolus insulīna devu
ievadēm, nosakot aprēķināto bolus daudzumu,
izmantojot funkciju Bolus Wizard (Bolus devas vednis).

Sensor Calibration BG (mmol/L or mg/dL) (Sensora
kalibrācijas BG (mmol/l vai mg/dl))

BG vērtība, ko izmanto sensora kalibrēšanai šādās
vienībās: mmol/l vai mg/dl.

Sensor Glucose (mmol/L or mg/dL) (Sensora glikozes
līmenis asinīs (mmol/l vai mg/dl)) Sensora glikozes vērtība.

ISIG value (ISIG vērtība) Ievades signāli (ISIG), ko nolasa no sensora un mēra
nanoampēros (nA).

CareLink Pro Lietošanas instrukcija   CSV dati 55



Vairāk par CSV failiem, ko eksportē CareLink Pro

Nosaukumā CSV faila augšpusē ir iekļauta šāda informācija:

• pacienta vārds;

• atlasīto ierīču saraksts un to sērijas numuri;

• atlasītais datumu diapazons.
 
Katram sleju blokam ir nosaukums, kurā iekļauta šāda informācija:

• ierīces nosaukums, uz kuru attiecas datu bloks;

• šīs ierīces sērijas numurs.

Ja dati netiek parādīti, kā paredzēts

Ir vairāki iemesli, kādēļ CSV dati tiek parādīti citādi, nekā paredzēts.

• Ierīces datuma vai laika maiņa var mainīt rādīšanas secību vai iznest ierakstus ārpus izvēlētā

parādāmā datumu diapazona.

• Ja starp ierīces nolasījumiem ir liela atstarpe, šīs ierīces dati var būt parādīti vairākos

blokos.
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Vārdnīca

A1c - glikozēts hemoglobīns

A1c tests - hemoglobīna A1c tests, ko izmanto, lai izskaidrotu glikozes līmeni asinīs kādā laika
periodā (dinamikā).

Apgabals zem līknes (Area Under the Curve — AUC) - norāda augsto un zemo noviržu lielumus,
kurus nosaka pēc iepriekš iestatītām vērtībām. Noviržu dati norāda uz augsto un zemo noviržu
biežumu. AUC apzīmē notikumu svarīgumu, norādot, cik tālu tie ir no parastā diapazona un cik
ilgi tie turpinās.

Apmaiņas attiecība - insulīna daudzums, kas nepieciešams, lai nodrošinātu vienu (1) ogļhidrātu
apmaiņu. (Skatiet arī ogļhidrātu attiecību.)

Audio bolus - sūkni var ieprogrammēt tā, lai, atlasot bolus insulīna devas lielumu (0,5 vai
1,0 vienība), lietotājs sadzird pīkstienu. Tas noder situācijās, kad ir grūti redzēt sūkņa pogas.

Augsts glikozes līmenis - sūknis atskaņo trauksmes signālu, ja sensors rāda, ka lietotāja sensora
glikozes līmenis ir virs šīs vērtības. Šo opciju var ieslēgt vai izslēgt.

Augšupielāde - process sūkņa vai mērītāja datu pārraidīšanai uz serveri CareLink® Personal.

Bazālais insulīns - atbilstoši sūknī iepriekš ieprogrammētam profilam un individuāli izvēlētam
ātrumam insulīna sūknis katru stundu automātiski veic nepārtrauktu insulīna infūziju. Sūknis
nodrošina insulīna dienas devu, kas parasti atbilst pamata insulīna nepieciešamībai organismā
neēšanas laikā (piemēram, naktī un starp ēdienreizēm).

Bazālās devas ātrums - sūkņa iestatījums, kas nodrošina nepārtrauktu insulīna infūziju, lai
noturētu stabilu glikozes līmeni starp ēdienreizēm un naktī. Bazālā insulīna deva imitē insulīna
piegādi no aizkuņģa dziedzera, kas nodrošina visu organismam nepieciešamo insulīnu un nav
saistīts ar pārtikas uzņemšanu.

Bazālās devas modeļi - lietotājs sūknī var ieprogrammēt līdz trim dažādiem bazālā insulīna devas
ievades ātruma modeļiem: standarta, A un B. Katrā modelī var iestatīt līdz 48 bazālās devas
ātrumiem.

Bazālās devas profils - bazālās devas ātrums ar sākuma un beigu laiku. Lietotājs sūknī var
ieprogrammēt vairākus profilus ar atšķirīgu bazālās devas diapazonu, lai 24 stundu laikposmā
nodrošinātu labāku glikozes līmeņa kontroli.

BG - glikozes līmeņa asinīs saīsinājums.

Bolus devas korekcijas faktors - norāda, par cik 1,0 insulīna vienība pazemina glikozes līmeni
asinīs. Šo koeficientu izmanto, lai aprēķinātu korekcijas bolus devu, kad cukura līmenis asinīs ir
augsts. (BG līmenis) – (BG mērķa diapazons) = X. X ÷ (bolus devas korekcijas faktors) = bolus
devas korekcijas lielums
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Bolus insulīns - insulīna deva, ko ievada, lai tas būtu pietiekamā daudzumā, kad ir sagaidāma
glikozes līmeņa asinīs celšanās (piemēram, pēc ēšanas vai uzkodām) vai kad jāsamazina augsts
glikozes līmenis asinīs līdz mērķa diapazonam.

Brīdinājums par rezervuāra iztukšošanos - ieprogrammējams brīdinājums, kas ziņo, kad sūkņa
rezervuārā atlicis noteikts skaits vienību, vai noteikts laiks, pēc kura rezervuārs būs tukšs.

CareLink® Personal - tiešsaistes pakalpojums, kas ļauj pārvaldīt diabēta datus internetā.

CH - ogļhidrāts

ComLink - radiofrekvenču (RF) uztvērējs un raidītājs, ko lieto, lai lejupielādētu sūkņa Paradigm
datus datorā.

Com-Station - ierīce, ko lieto, lai lejupielādētu sūkņa MiniMed 508 datus un pārsūtītu trešās
personas mērītāja datus uz datoru.

Darbība - insulīna mērījums, kas tiek iestatīts un izmantots ar metodi Easy Bolus (Viegla bolus
devas ievadīšana).

Dual Wave® bolus - nekavējoties piegādājamās parastās bolus devas apvienojums ar pagarinātā
viļņa bolus devu. Pagarinātā viļņa daļa tiek vienmērīgi ievadīta noteiktā laikposmā.

Easy Bolus™ - metode parastās bolus devas ievadei, izmantojot sūkņa pogu Easy Bolus (Viegla
bolus devas ievadīšana).

HbA1c - glikozēts hemoglobīns.

HbA1c tests - hemoglobīna A1c tests, ko izmanto, lai interpretētu glikozes līmeņa asinīs kontroli
vai līmeņu vidējās vērtības 2–3 mēnešu laikā.

Hiperglikēmija - paaugstināts glikozes līmenis asinīs, kas ir redzams, uzraugot glikozes līmeni
asinīs, novērojot vai nenovērojot vienu vai visus šādus simptomus: nelabums, vemšana,
neskaidra redze, galvassāpes, gremošanas traucējumi, bieža liela apjoma urinēšana, letarģija.

Hipoglikēmija - zems glikozes līmenis asinīs, kas ir redzams, uzraugot glikozes līmeni asinīs,
novērojot vai nenovērojot vienu vai visus šādus simptomus: spēcīgs izsalkums, trīce vai tremors,
svīšana, redzes izmaiņas, reibonis, galvassāpes, neskaidra runa, pēkšņas garastāvokļa vai
personības izmaiņas.

Infūzijas komplekts - ierīce, ko lieto, lai ievadītu un nostiprinātu zem ādas kanulu, ievadītu
insulīnu no sūkņa pa caurulītēm līdz ievadīšanas vietai.

Insulīna jutīgums - daudzums mmol/l (vai mg/dl) vienībās, par kādu viena insulīna vienība
samazina jūsu glikozes līmeni asinīs (BG). (funkcijas Bolus Wizard (Bolus devas vednis) dati).

Insulīna koncentrācija - insulīna deva vai veids, ko ārsts izrakstījis lietotājam. Tas ietekmē ātrumu,
ar kādu sūknis ievada insulīnu. Ja mainās lietotāja insulīna koncentrācija, sūknī jāpārprogrammē
bazālās devas modeļi, maksimālās bazālās un bolus devas ievades ātrums.

ISIG - sensora vērtības, kas norāda, vai devēja elektroniskās ierīces ar sensoru pastiprinātā sistēmā
darbojas pareizi. Ja ISIG vērtība ir zemāka par 24,00 nA vai lielāka par 29,00 nA, sazinieties ar
izstrādājuma servisu. Devēja nomaiņa var aizņemt zināmu laiku.

Īslaicīga bazālā deva - īslaicīga, vienreizēja bazālā insulīna piegāde noteiktā daudzumā un ilgumā.
Izmanto, lai atbalstītu nepieciešamību pēc insulīna īpašu aktivitāšu vai apstākļu gadījumos, kas
neietilpst parastā ikdienas kārtībā.

Īslaicīgs (Temp) - īslaicīgs.

Kalibrācijas atgādinājums - sūknis ik pēc 12 stundām automātiski iedarbinās BG mērītāja
trauksmes signālu (st.st.:min.min.), signalizējot, ka pašreizējā kalibrētā vērtība vairs nav derīga.
Opcijas Cal Reminder (Kalibrēšanas atgādinājums) vērtība ir laikposms pirms pašreizējās
kalibrētās vērtības derīguma beigām, lai atgādinātu lietotājam, ka būs jāveic kalibrācija.
Piemēram, ja opcija Cal Reminder (Kalibrēšanas atgādinājums) ir iestatīta uz 2 stundām,
BG mērītāja trauksmes signāls (st.st.:min.min.) tiks iedarbināts 2 stundas pirms kalibrēšanas
laika.

Ketona tests - ketons ir blakusprodukts, kas rodas, kad organisms enerģijas ieguvei sadedzina
taukus, nevis glikozi. Tas var norādīt uz insulīna trūkumu organismā. Ketona testā nosaka asinīs
vai urīnā koncentrētā ketona daudzumu.
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Korekcijas bolus - insulīna daudzums, kas nepieciešams, lai augsts glikozes līmenis asinīs
pazeminātos līdz mērķa diapazonam.

Maksimālā bolus - maksimālais bolus insulīna daudzums, ko sūknis ievada vienā reizē. (Iestata
lietotājs.)

Maksimālā bolus insulīna deva - maksimālais bazālā insulīna daudzums, ko sūknis ievada vienā
reizē. (Iestata lietotājs.)

Manuāla bolus - papildu opcija, kas pieejama izvēlnē BOLUS, ja funkcija Bolus Wizard (Bolus devas
vednis) ir aktīva. Viena metode bolus ieprogrammēšanai bez funkcijas Bolus Wizard (Bolus
devas vednis) izmantošanas.

Mērītāja opcija - opcija, kas ļauj sūknim saņemt BG rādījumus no saistītā BG mērītāja.

Mērītājs - medicīniska ierīce aptuvenai glikozes koncentrācijas asinīs noteikšanai. Nelielu asins
pilienu novieto uz vienreizējas lietošanas testa strēmeles, kuru mērītājs nolasa, un rādījumi tiek
izmantoti glikozes līmeņa asinīs aprēķināšanai. Pēc tam mērītājā ir redzams līmenis šādās
vienībās: mmol/l vai mg/dl.

Modelis, standarta - parastais bazālās devas modelis, kas atbilst jūsu ikdienas aktivitātēm. Ja
funkcija Patterns (Modeļi) ir izslēgta, sūknis darbojas pēc jūsu standarta (bazālā) modeļa.

Modeļa funkcija - paplašināta sūkņa funkcija, kas ļauj ieprogrammēt izvēles bazālās devas
(A modelis, B modelis), kas atbalsta aktivitātes vai glikozes līmeņa asinīs modeļus, kas neatbilst
parastai ikdienas kārtībai, taču dzīves ritmā var gadīties bieži. Šādas aktivitātes var būt kādas
sporta nodarbības, ar kurām nodarbojaties vienreiz nedēļā, gulēšanas laiku izmaiņas nedēļas
nogalēs vai hormonālās izmaiņas menstruāciju cikla laikā.

Ogļhidrātu attiecība - ogļhidrātu daudzums, ko noārda 1 insulīna vienība. (Skatiet arī apmaiņas
attiecību.)

Ogļhidrātu vienības - pārtikas ievade, izmantojot funkciju Bolus Wizard (Bolus devas vednis).
Ievadīta (ogļhidrāti) gramos vai apmaiņas devās.

Pagarinātā viļņa daļa - (Sq) dubultā viļņa bolus devas otrā daļa. Dubultā viļņa daļa tiek ievadīta
vienmērīgi noteiktā laikposmā pēc tam, kad ir piegādāta parastā viļņa daļa.

Papildu bolus - metode jebkuras bolus devas ievadei, izmantojot sūkņa pogu Express Bolus
(Papildu bolus devas ievadīšana).

Parastā bolus - noteikta insulīna daudzuma tūlītēja ievade.

Pārtikas bolus - insulīna deva, kas nepieciešama, lai kompensētu sagaidāmu glikozes līmeņa asinīs
celšanos pēc ēšanas.

Raidītāja ID - pašreiz lietotā raidītāja sērijas numurs.

RF - radiofrekvence (RF).

Saite
(1) Ieslēgt un iestatīt mērītāja iespēju, kas ļauj sūknim saņemt BG rādījumus no mērītāja, kas
komunicē ar sūkni.
(2) Šo terminu saistībā ar sistēmu lieto, arī runājot par teksta hipersaitēm. Ja uz tām noklikšķina,
nokļūst citā sistēmas vietā vai citā tīmekļa vietnē.

Square Wave® bolus - bolus deva, kas tiek ievadīta vienmērīgi noteiktā laikposmā (no 30 minūtēm
līdz 8 stundām).

Suspend (Apturēt) - sūkņa funkcija, ar kuru tiek apturēta insulīna ievade. Visas notiekošās un/vai
uzsāktās ievades tiek atceltas. Bazālās devas ievade tiek apturēta līdz restartēšanai.

Vidējā absolūtā starpība, % (Mean Absolute Difference — MAD%) - atspoguļo sensora
kalibrācijas precizitātes līmeni atbilstoši BG mērītāja rādījumiem. Jo mazāks ir šis skaitlis, jo
lielāka ir kalibrācijas precizitāte. MAD% aprēķina, starpību starp sensora glikozes līmeņa un
BG mērierīces rādījumu tuvu esošiem pāriem dalot ar BG mērierīces rādījumu un pēc tam
aprēķinot vidējo vērtību no visiem pāriem.

Zems glikozes līmenis asinīs - sūknis atskaņo trauksmes signālu, ja sensors rāda, ka lietotāja
sensora glikozes līmenis ir zem šīs vērtības. Šo opciju var ieslēgt vai izslēgt.
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